NECRTEL
NETWORKS

Preside Multiservice Data Manager

Service Provisioning for |P
VPN Global Update

User Guide

241-6001-601






Preside Multiservice Data Manager

Service Provisioning for IP VPN Global
Update
User Guide

Publication: 241-6001-601
Document status: Standard
Document version: 14.3RSUP
Document date: December 2003

Copyright © 2003 Nortel Networks.
All Rights Reserved.

Printed in Canada

NORTEL, NORTEL NETWORKS, the globemark design, the NORTEL NETWORKS corporate logo, PRESIDE,
and PASSPORT are trademarks of Nortel Networks.







Publication history

December 2003

14.3RSUP Standard
Commercial availability

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



6  Publication history

241-6001-601 14.3RSUP



Contents

About this document 11
Who should read this document and why 11

What you need to know 12

How this document is organized 12

What's new in this document 12

Text conventions 12

Related documents 14

Chapter 1
IP VPN global update tool overview 15
Overview 15

Route Reflector 16

Auto Discovery 17
Architecture 18

IP VPN global server 18

IP VPN database 18

End-to-end server 20

IP VPN global update CLI 20

IP VPN global update GUI 20
Limitations and restrictions 21

Chapter 2
Configuring the servers and starting the tool 23
Server options 23
Configuring the servers 24
Configuring the end-to-end server 24
Configuring the IP VPN global server 25

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



8 Contents

Changing the server port number and host name 26
Configuring and accessing the server host 27
Starting the IP VPN global update tool (GUI) 28
Preside MDM window 28
Nodal Provisioning main window 28
Network Viewer Start Tool menu 28
Starting the IP VPN global update tool (CLI) 31

Chapter 3
Installing the IP VPN global update tool 33
System requirements 33
Installing the IP VPN global update tool software 34
Installing and configuring MDM software 34
Updating the license 34

Chapter 4
IP VPN global update tool GUI 37
IP VPN global update tool main window 37
Menu bar 40
File menu 40
Edit menu 40
Selected menu 40
Tools menu 42
Help menu 43
Hierarchy tree panel 43
Details panel 43
IP VPN global update tool GUI dialogs 55
Options dialog 56
Confirm Provisioning Options dialog 59
Include VR dialog 62
CoS Policy Group dialog 63
Add New CoS Policy dialog 66
Modify CoS Policy dialog 69
New Flow Classification dialog 71
Modify Flow Classification dialog 73
Exclude VR dialog 75

241-6001-601 14.3RSUP



Contents 9

Error and Message dialogs 76
Progress dialogs 77

Chapter 5
Using the IP VPN global update tool GUI 79

Selecting a device view for provisioning, and saving provisioning
data 79

Service provider selected menu procedures 80
Adding a new customer 80
Customer selected menu procedures 81
Removing a customer 81
Adding a new VPN to a customer 82
VPN selected menu procedures 83
Addinga VR to a VPN 83
Removing a VPN 85
Applying IP CoSto a VPN 86
VR selected menu procedures 90
Excluding or deleting a VR from an existing VPN 90
Creating a new customer VPN 91

Chapter 6

Using the IP VPN global update tool CLI 93
Creating a VPN 93

Deleting a VPN 97

Adding a VR to a VPN 97

Excluding a VR from a VPN 98

Deletinga VR 99

Adding a policy groupto a VR ina VPN 99
Deleting a policy group from a VR ina VPN 101
Configuring a tosMask attribute on a VR 102
Updating a password 103

Chapter 7

Commands 105
help 105

createvpn 106

createvr 107

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



10

Contents

includevr 108
excludevr 111
deletevr 113
deletevpn 115
settosmask 116
settosmarking 118
addpolicy 120
deletepolicy 122
listvpn 124
listcustomer 125
updatepasswd 125

Index

127

241-6001-601 14.3RSUP



11

About this document

This document explains how to use the Internet Protocol (IP) virtual private
network (VPN) global update tool.

ATTENTION If you have upgraded to Preside MDM Release 14.3, use the

IP VPN Service Provisioning tool to configure RFC 2764
VPNSs with auto-discovery enabled. See 241-6001-616
Preside MDM IP VPN Service Configuration User Guide.
Further information can be found the the 14.3 Release
Supplement.

The following topics are discussed in this section:

“Who should read this document and why” (page 11)
“What you need to know” (page 12)

“How this document is organized” (page 12)
“What's new in this document” (page 12)

“Text conventions’ (page 12)

“Related documents’ (page 14)

Who should read this document and why

Thisguideisintended for personnel who provision |PVPNs on Passport 7000
15000 and 20000 devices.

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



12  About this document

What you need to know

This document assumes that you have knowledge of the Nortel Networks
Preside Multiservice DataManager (M DM) and have an understanding of the

Passport product.

How this document is organized
Theinformation in this document is organized as follows:

» “Installing the IP VPN global update tool” (page 33) describes the IP
VPN global update tool, and its software components.

* “Installing the IP VPN global update tool” (page 33) describes the
software required for the |P VPN global update tool and how to install it.

e “Configuring the servers’ (page 24) describes how to configure the end-
to-end server and the IP VPN global server, aswell as system
requirements and how to launch the IP VPN global update tool.

e “IPVPN global update tool GUI” (page 37) describes the main window
and dialogs of the IP VPN global update tool user interface.

e “Using the IP VPN global update tool GUI” (page 79) contains the
procedures you can perform with the IP VPN Global Update tool
graphical user interface.

e “Commands’ (page 105) lists the available commands and their
parameters.

e “Using the IP VPN global update tool CLI" (page 93) contains
procedures you can perform with the | P global update tool.

What's new in this document
There are no changes in this document for this release.

Text conventions
This document uses the following text conventions:

e nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or
text that appears on your screen.

241-6001-601 14.3RSUP



About this document 13

e nonproportional spaced bold type
Nonproportional spaced bold type represents wordsthat you should type
or that you should select on the screen.

* talics
Statements that appear in italicsin a procedure explain the results of a
particular step and appear immediately following the step.

Words that appear initalicsin text are for naming.

* [optional _paraneter]

Words in square brackets represent optional parameters. The command
can be entered with or without the words in the square brackets.

e <general _ternp

Wordsin angle brackets represent variableswhich areto be replaced with
specific values.

 UPPERCASE,lowercase

In MDM, uppercase and lowercase letters that appear in UNIX
commands and parameters must be matched exactly. The system matches
upper and lowercase characters differently.

This symbol separates items from which you may select one; for
example, ON|OFF indicates that you may specify ON or OFF. If you do
not make a choice, a default ON is assumed.

Three dots in acommand indicate that the parameter may be repeated
more than once in succession.

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



14  About this document

The term absolute pathname refers to the full specification of a path starting
from the root directory. Absolute pathnames always begin with the slash (/)
symbol. A relative pathname takes the current directory as its starting point,

and starts with any a phanumeric character (other than /).

Related documents
See the following documents for related information:

e 241-6001-303 Preside MDM Administrator Guide
e 241-6001-310 Preside MDM Server Reference Guide
e 241-6001-610 Preside MDM Nodal Provisioning User Guide

e 241-6001-611 Preside MDM Nodal and Service Provisioning Reference
Guide

241-6001-601 14.3RSUP
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Chapter 1
IP VPN global update tool overview

ATTENTION If you have upgraded to Preside MDM Release 14.3, use the
IP VPN Service Provisioning tool to configure RFC 2764
VPNSs with auto-discovery enabled. See 241-6001-616
Preside MDM IP VPN Service Configuration User Guide.
Further information can be found the the 14.3 Release
Supplement.

For an overview of the Internet Protocol (I1P) Virtual Private Network (VPN)
global update tool, see the following sections:

“Overview” (page 15)
e “Architecture’ (page 18)
» “Limitations and restrictions’ (page 21)

Overview
The IP VPN global update tool allows you to set up and perform global

updating of acustomer IP VPN on Passport 7000, 15000, and 20000 devices
through either a graphical user interface (GUI) or acommand line interface
(CL1). Thetool can support a maximum of 1000 VRs per VPN.

The tool alows you to perform the following tasks:

» createavirtua router (VR) component

* includeaVRinaVPN

e excludeaVR fromaVPN

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



16 Chapter 1 IP VPN global update tool overview

e set up aborder gateway protocol (BGP) between VRsin aVPN
» define P class of service (CoS) policy groups for the VRsin aVPN
» list operational VPN information

The IP VPN global update tool also provides the following functionality:
*  routereflector

e autodiscovery

Route Reflector
The IP VPN Globa Update Tool uses route reflector functionality which
allows you to specify which VRsin the VPN will be route reflectors. If you
configure aVR asaroute reflector, the VR sendsinformation to other VRsin
the VPN. Thisreduces network traffic, since only the VRs configured asroute
reflectors send information to the other VRs.

IP tunneling allows you to connect two physically separated networks that
share the same (private) address space through an | P network with adifferent
(public) address space. When you include or exclude a VR, the tunnels and
ARP tables are updated. Address resolution protocol (ARP) tables map
private | P addresses to public | P addresses.

The figure “1P tunneling example” (page 17) shows a sample configuration
with two VPNs.

241-6001-601 14.3RSUP
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Figure 1
IP tunneling example
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Auto Discovery
The IP VPN global update tool provides the option to run the tool in auto
discovery mode. Auto discovery mode allows the Passport Virtual Routers
(VRs) to dynamically exchange the IP VPN topology information across
VPN sites every time a customer VR is added or deleted.

When you select the auto discovery mode, you reduce the amount of
provisioning required when adding or deleting new VPN sites by eliminating
the following tasks:

» provisioning a static ARP entry for each remote I P tunnel endpoint
defined on the customer VR

»  gpecifying the destination address while provisioning a PTMP I P tunnel
on the customer VR

e provisioning local IBGP peers on the customer VR

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



18 Chapter 1 IP VPN global update tool overview

e visiting all remote customer VRs provisioned on remote Passports to
update their corresponding IBGP peers, PTMP I P tunnels and ARP
entries with information related to the newly provisioned customer VR

Architecture

The IP VPN global update tool consists of the following software
components:

* |IPVPN global server

* |PVPN database

*  End-to-end server

e |PVPN global update CLI
e |PVPN global update GUI

IP VPN global server
The IP VPN global server provides the main functionality of the I[P VPN
global update tool. The global server also communicates with the P VPN
database to store, update, and list customer VVPN-related information. The IP
VPN global server uses the end-to-end server to communicate with Passport
switches and to send provisioning commands to them. The global server also
accesses the IP VPN global database to store and list VPN information.

IP VPN database
The IP VPN database groups and stores VPN-related information. The IP
VPN global update tool collects data for a specific VPN when performing I P
VPN global updating. The database is located in /opt/M agellanNM S/data/
vpn/db.

The database lists all VRs in each VPN. The database consists of one global
table containing alist of all VPNs. The VPN list includes the customer name
and ID, and the VPN name and ID. The customer name and VPN name
uniquely identifiesa VPN.

Thetable“VPN list fields” (page 19) describes the fieldsin the VPN list.
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Table 1
VPN list fields
Field Description
CUSTOMER VPN customer name
CUSTOMER_ID unique customer identifier
VPN the name of the VPN
VPN_ID unique VPN identifier
AS autonomous system ID for BGP routing
USERID the default userID which you can use to log in to
all Passports in the VPN
PASSWD the password for the userlD
AUTODISCOVERY indicates that the tool is running in autodiscovery
mode

The database also providesa VR table for each VPN. The VR table stores the
following information:

* theVRsin the specific VPN

» thepublic and private IP address

* the network mask

» thePassport on which a VR exists

The table describes the fields in the VR table.

Table 2
VR table fields
Field Description
VR name of the virtual router in the VPN
PP name of the Passport in which the VR exists
(Sheet 1 of 2)
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IP VPN global update tool overview

Table 2
VR table fields (continued)
Field Description
CARRIER_VR the carrier VR to which the customer VR is
mapped
PRIVATE_IP IP address for the logical interface on the tunnel

PRIVATE_NETMASK
PUBLIC_IP

PUBLIC_NETMASK
ROUTEREFLECTOR

USERID

PASSWD
TOPOLOGY

IP port of the VR
network mask for the private IP address

IP address of the logical interface on the virtual
media IP port of the carrier VR

the network mask of the public IP address

indicates whether a VR acts as a route reflector
in the VPN

the userID when logging into the Passport where
the VR exists

the password for the userID

indicates whether the VR is a hub or spoke

(Sheet 2 of 2)

End-to-end server
The end-to-end server acts as an intermediary between the IP VPN global
update server and the Preside Multiservice Data Manager (MDM) command
console functional process (CMCFUN) server. The CMCFUN server
forwards operator commands to Passport devices for execution.

IP VPN global update CLI

IP VPN global update GUI

IP VPN global update CLI lets you perform global updates by executing

commands.

The IP VPN global update GUI lets you perform global updates using a
graphical user interface. The IP VPN GUI uses the same interface to
communicate with the IP VPN server as that which is used by the CLI.
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Limitations and restrictions
Thefollowing limitations and restrictions apply to the IP VPN global update
tool:

e« ThelPVPN globa update server is supported on the Solaris platform
only.

* ThelPVPN global update CLI client issupported onthe Solarisplatform
only.

*  Only Passport 7000 and Passport 15000 products are supported.
» Thereisno support for database resynchronization.
e« ThelPVPN globa updatetool islimited to single user access.

e Thereisno support for access port or carrier provisioning.

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



22 Chapter 1 IP VPN global update tool overview

241-6001-601 14.3RSUP



23

Chapter 2
Configuring the servers and starting the tool

ATTENTION If you have upgraded to Preside MDM Release 14.3, use the
IP VPN Service Provisioning tool to configure RFC 2764
VPNSs with auto-discovery enabled. See 241-6001-616
Preside MDM IP VPN Service Configuration User Guide.
Further information can be found the the 14.3 Release
Supplement.

For configuration and start-up instructions for the I[P VPN global update tool,
see the following sections:

e “Server options’ (page 23)

e “Configuring the servers’ (page 24)

» “Starting the IP VPN global update tool (GUI)” (page 28)
o “Starting the IP VPN global update tool (CLI)" (page 31)

Server options
Note: To run the IP VPN global server, the end-to-end server must be
running. The end-to-end server checksfor avalid license key. See
“Updating the license” (page 34).

The following IP VPN global server options apply to the IP VPN global
update tool:
e -hto obtain help on acommand.

e -logto turn logging off or on. The log files are located in /opt/
MagellanNM S/data/vpn/log.

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP
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e -pto specify aport (by default, the port is 6800).

» -dbto specify an alternate path for the database. By default, the database
islocated in /opt/MagellanNM S/data/vpn/db. The file name of the
database is the customer_id number.

Configuring the servers

Before using the IP VPN global update tool, you need to do some or all of the
following configuration tasks:

*  “Configuring the end-to-end server” (page 24)
e “Configuring the IP VPN global server” (page 25)
e “Changing the server port number and host name” (page 26)

e “Configuring and accessing the server host” (page 27)

Configuring the end-to-end server
Note: Only perform this procedure if the end-to-end server is not
configured. If the server is configured, perform the procedure
“Configuring the IP VPN global server” (page 25).

You need to use the Server Manager (SVM) Administration tool to edit the
entry for the IP VPN end-to-end server. For more information on the end-to-
end server, see 241-6001-310 Preside MDM Server Reference Guide. For
information on the Server Manager Administration (SVM) tool, see
241-6001-303 Preside MDM Administrator Guide.

1 While logged on as root, in the Preside MDM window, select System ->
Administration -> Server Administration.
The Server Manager Administration tool window opens.
2 From the Security menu, select Enable Editing.
The SVM Enter Edit Password dialog opens and prompts for a password.
3 Ifrequired, type a valid password and click OK.
The Server Manager Edit Server dialog opens.
4 From the Edit menu, select the New command.
5 In the Descriptive name field, type the following information:

end-to-end server
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Chapter 2 Configuring the servers and starting the tool 25

6 Inthe Startup command field, type the following information:

/ opt/ Magel | anNMS/ bi n/ et eserver [-h] [-p <portno>] [-t
<ti meout >]

where:
{-h} displays help

[-p <portno>] specifies the TCP port number for monitoring incoming
requests. The default value is 6600.

[-t <timeout>] specifies the sleep timeout seconds before attempting
connection to servers.

Note: The port number must not be used by any other process.
7 Enable the Automatic startup at reboot time option.
8 Click Save and Start.

The data you entered is stored and the server is started.
9 From the File menu, choose Refresh Server list.

An updated server list is displayed, including the end-to-end server.

Configuring the IP VPN global server
You need to use the Preside Multiservice Data Manager (MDM) Server
Manager (SVM) Administration tool to edit the entry for the IP VPN global
server. For more information on the IP VPN global server, see 241-6001-310
Preside MDM Server Reference Guide.

1  While logged on as root, on the Preside MDM window, select System ->
Administration -> Server Administration.
The Server Manager Administration Tool window opens.
2 From the Security menu, select Enable Editing.
The SVM Enter Edit Password dialog opens and prompts for a password.
3 Ifrequired, type a valid password and click OK.
The Server Manager Edit Server dialog opens.
4 From the Edit menu, select the New command.
5 In the Descriptive hame field, type the following information:

i pvpn server

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP



26 Chapter 2 Configuring the servers and starting the tool

6 Inthe Startup command field, type the following information:
/ opt/ Magel | anNMS/ bi n/ i pvpnserver [-p <portno>] [-1o0g]
where:

[-p <portno>] specifies the TCP port number for monitoring incoming
requests. The default value is 6800.

[-log] specifies whether you want logging turned on. If you do not enter
this option, logging is not turned on.

Note: The port number must not be used by any other process.
7 Enable the Automatic startup at reboot time option.
8 Click Save and Start.

The data you entered is stored and the server is started.
9 From the File menu, choose Refresh Server list.

An updated server list is displayed, including the ipvpn server.

Changing the server port number and host name
If your setup runsthe IP VPN global server on a port other than the defaullt,
you need to update the client resource file for the provisioning tool and
reconfigure the server.

1 While logged on as root, edit the resource file:
lopt/MagellanNMS/cfg/IP_VPN_Server.txt
2 Set the host parameter:
host = <hostname>|<ipaddress>
where:
<host nane> is the host name.
<i paddr ess> is the address of the host server.

3 To change the server port number from the default value of 6800, set the
port parameter to the appropriate port number:

port = <portno>
where:

<portno> is the TCP port number.

241-6001-601 14.3RSUP



Chapter 2 Configuring the servers and starting the tool 27

5

Go to the Preside MDM Server Manager Administration tool and edit the
server port number option. See “Configuring the IP VPN global server”
(page 25).

Restart the IP VPN global server.

Configuring and accessing the server host
By default, the local host is used as the server host. If you are running the
client on adifferent host than the server, you need to update the resource and
host files.

Configuring the server host

1

While logged on as root, edit the resource file:
lopt/MagellanNMS/cfg/IP_VPN_Client.txt

Set the host parameter:

host = <hostname>|<ipaddress>

where:

<host name> is the host name.

<i paddr ess> is the address of the host server.

To change the server port number from the default value of 6800, set the
port parameter to the appropriate port number:

port = <portno>
where:
<portno> is the TCP port number.

Go to the Preside MDM Server Manager Administration tool and edit the
server port number option. See “Configuring the IP VPN global server”
(page 25).

Accessing the server host

1

While logged on as root, display the contents of the hosts file:
more /etc/hosts

Check that the file contains an entry with the IP address and host name
of the server.

If the entry is not listed, open an edit view of the resource file and add the
IP address and host name on a new line:

<ipaddress> <hostname>

Preside MDM Service Provisioning for IP VPN Global Update User Guide 14.3RSUP
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Starting the IP VPN global update tool (GUI)

You can start the IP VPN global update tool from the following pointsin
Preside Multiservice Data Manager (MDM):

e “Preside MDM window” (page 28)
*  “Nodal Provisioning main window” (page 28)
*  “Network Viewer Start Tool menu” (page 28)

Preside MDM window
1 Start the Preside Multiservice Data Manager (MDM).

2 Inthe Preside MDM window, select Configuration -> Passport Devices ->
Service Provisioning -> IP VPN Global Update.

The Service Provisioning - IP VPN Global Update tool main window
opens.

Nodal Provisioning main window
1 Start the Preside Multiservice Data Manager (MDM).

2 Launch the Nodal Provisioning tool. See in 241-6001-610 Preside MDM
Nodal Provisioning User Guide.

3 Inthe menu bar of the Nodal Provisioning tool main window, select
External Tools -> Service Provisioning -> IP VPN Global Update.

Network Viewer Start Tool menu
1 Launch the Preside Multiservice Data Manager (MDM).

2 Inthe MDM window, select -> Fault -> Network Viewer.
The Network Viewer window opens.

3 Inthe Network Viewer, select the nodes required to provision the IP VPN
service by doing one of the following:

» click on the background of the Network Viewer window, drag the
mouse and release it when all the desired nodes are included in the
area where you dragged the mouse

» press the shift key and click on the nodes that are required to create
the VPN.

4  Right click the mouse button while holding the shift key and select Start
Tool -> Configuration -> Service Provisioning -> IP VPN Global Update.
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The Select Customer and VPN dialog opens to let specify the customer
and VPN to which you want to add the selected nodes.

The dialog contains a list of all the virtual routers (VRs) that you selected
in the Network Viewer.

5 If you wish to use an existing customer, then select the customer name
from the Customer Name drop down list. The list of VPNs for the selected
customer appears in the VPN Name drop list.

If you wish to create a new customer, then select New Customer. The New
Customer dialog opens. The VPN Name drop down list is empty.

22 New Customer

In the New Customer dialog, complete the following tasks:
a. Enter a customer name in the Customer Name field.

b. Enter a customer identifier in the Customer Identifier field.
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c. Click OK.

the New Customer dialog closes. The name of the new customer is
added to the customer list and is automatically selected.

6 Ifyouwish to use an existing VPN, in the select customer and VPN dialog,
select an existing VPN from the VPN Name drop down list.

If you wish to create a new VPN, in the select customer and VPN dialog,
select the New VPN button. The New VPN dialog opens.

7 Entera VPN name, identfier, User ID, and Password, and if desired, select
Auto Discovery On.

8 Select OK to create the new VPN.
The dialog closes and the following occurs:

« the new VPN is added to the VPN Name drop down list and is
selected

Note: If you selected an existing customer and VPN, and one of the
nodes selected in the Network Viewer is already part of this VPN, that
node is not added to the list since a switch can only have one virtual router
per VPN.
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9 Inthe Select Customer and VPN dialog, select OK.

* The IP VPN Global Update tool opens with the specified customer
and VPN opened in the hierarchy tree

» Avvirtual router is created for every node that you selected in the
Network Viewer

Starting the IP VPN global update tool (CLI)

You can access the |P VPN global update tool CLI from the Server Manager
Administration tool.

1 Start the Server Manager Administration tool.

For the procedure to start the Server Manager Administration tool, see
241-6001-303 Preside MDM Administrator Guide.

2 Enter the appropriate IP VPN global update tool command from the
command line.
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Chapter 3
Installing the IP VPN global update tool

ATTENTION If you have upgraded to Preside MDM Release 14.3, use the
IP VPN Service Provisioning tool to configure RFC 2764
VPNSs with auto-discovery enabled. See 241-6001-616
Preside MDM IP VPN Service Configuration User Guide.
Further information can be found the the 14.3 Release
Supplement.

For system requirements and installation instructions, see the following
sections:

e “System requirements’ (page 33)
» “Installing the IP VPN global update tool software” (page 34)
+  “Updating the license” (page 34)

System requirements
The current supported platform of the IP VPN global update tool is SPARC
Solaris.

The IP VPN global update tool requires the following software:

*  Preside Multiservice Data Manager (MDM) software package. The IP
VPN global update tool is part of the MDM package on the MDM CD-
ROM.

» thefollowing third-party software supplied by Nortel Networks on the
MDM CD-ROM:

— associated JRE patches for Solaris
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e avalidlicense key

Installing the IP VPN global update tool software
For the IP VPN global update tool you need to install both Nortel Networks
and third-party software from the Preside Multiservice Data Manager
(MDM) CD-ROMs. Refer to the Release Supplement for the location of the
required software.

Installing the IP VPN global update tool software involves the following
installation procedures:

» “Installing and configuring MDM software” (page 34)
»  “Updating thelicense” (page 34)

Installing and configuring MDM software
The IP VPN global updatetool is part of the Preside Multiservice Data
Manager (MDM) software package. When you load the Preside MDM
software from CD-ROM with the Install Anywhere program you When you
load the Preside MDM software from CD-ROM with the Install Anywhere
program as described in 241-6001-100 Preside MDM Installer Guideyou are
instructed to:

» load the Solaris software patches for the Java Runtime Environment that
is needed for the IP VPN global update tool

* load the Preside MDM software with the Install Anywhere program.
When you run the Install Anywhere program to load the Preside MDM,
the program automatically loads the software packages required for the.
These packages are Preside MDM base and the Java Runtime
Environment (JRE). You do not need to load any additional packages.

Updating the license
You need alicense beforeyou can run 1PV PN global updatefor thefirst time.
You only need to perform this procedure if the license you have for Preside
MDM does not allow you to run IP VPN Globa update.

Nortel Networks provides thisinformation along with the Preside
Multiservice Data Manager (MDM) software onthe MDM CD-ROM. If you
do not have this information, contact your Nortel Networks account
representative.
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Chapter 3 Installing the IP VPN global update tool 35

To add the license key and customer identifier do the following:

1 Login as root.

2 Using a UNIX editor open the following file for editing:
/etc/opt/Magell an/ LI dicenses. cfg

Add the license key to the file.

Check what you typed carefully.

Save the file and exit from it.

o o AW

Open the following file for editing:
/ et c/opt/ Magel | an/ LI Ccust Name. cfg
7  Check what you typed carefully.

8 Save the file and exit from it.
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IP VPN global update tool GUI

For a description of the IP VPN global update tool graphical user interface
(GUI), see the following sections:

IP VPN global update tool main window
IP VPN dialogs

IP VPN global update tool main window
ThelP VPN GUI application consists of amain window from which you can
initiate or perform provisioning tasks. The IP VPN global update GUI
application lets you perform the following tasks:

create a new customer

remove a customer

add anew VPN to a customer
include VRsinthe VPN

add aVR to an existing VPN
excludea VR from an existing VPN

apply IP CoStoaVPN

See dso:

“Options dialog” (page 56)
“Confirm Provisioning Options dialog” (page 59)
“Include VR dialog” (page 62)
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e “CoS Policy Group dialog” (page 63)

e “Add New CoS Policy dialog” (page 66)

* “Maodify CoS Policy dialog” (page 69)

*  “New Flow Classification dialog” (page 71)

* “Modify Flow Classification dialog” (page 73)

* “Exclude VR didog” (page 75)

e “Error and Message dialogs’ (page 76)

* “Progressdialogs’ (page 77)

e “Using the IP VPN global update tool GUI” (page 79)

For anillustration of the IP VPN global update tool main window, see the

figure“IP VPN Global Update Tool main window with VR/
LAKEPLACID_VPN148 selected” (page 39).
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Figure 2
IP VPN Global Update Tool main window with VR/LAKEPLACID_VPN148 selected

Service Provisioning — IP-V¥PN Global Update
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The IP VPN global update main window consists of the following elements:
*  “Menubar” (page 40)

e “Hierarchy tree panel” (page 43)

* “Details panel” (page 43)
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Menu bar
The menu bar islocated at the top of the IP VPN Global Update tool main
window. It contains the following menu options:

e “Filemenu” (page 40)

e “Edit menu” (page 40)

e “Selected menu” (page 40)
e “Help menu” (page 43)

File menu
The File menu contains the following command:
« Exit
Exit closesthe IP VPN global update main window.

Edit menu
The Edit menu contains the following command:

e Options...
Options... opens an Options dialog which displays a single provisioning
tab where provisioning options may be edited. See “ Options dialog”
(page 56).

Selected menu
The commandsthat are availablein the Sel ected menu vary with theitem you
select (service provider, customer, VPN, or VR) inthe hierarchy tree. Seethe
following sections:

* “Serviceprovider selected menu” (page 41)
e “Customer selected menu” (page 41)
*  “VPN selected menu” (page 41)
*  “VR selected menu” (page 42)
Note: The Selected menu contains the same menu items as the pop-up

menu that appears when you click the mouse menu button on an itemin
the hierarchy treein the IP VPN global update main window.
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Service provider selected menu
When you select service provider from the provisioning panel of the main
window, the Selected menu contains the following command:

*  Add new customer
Add new customer adds a new customer to the service provider. The
customer is created locally in the GUI tool. When you click Apply inthe
IPVPN global update mainwindow, the customer isstoredinthelPVPN
server database.

* Help
Help accesses the on-line documentation for the Service Provider
Selected menu.

Customer selected menu
When you select a customer in the provisioning panel, the selected menu
contains the following commands:

* Addnew VPN
Add new VPN adds anew VPN to the selected customer. The VPN is
created locally in the GUI tool and is stored in the IP VPN server
database when you click Apply in the main window.

¢ Remove
Remove removes the selected customer from the |P VPN server
database.

Note: The Remove command is only available when the selected
customer has no VPNSs.

* Help
Help accesses the on-line documentation for the Customer Selected
menu.

VPN selected menu
When you select a VPN from the provisioning panel, the selected menu
contains the following commands:

— Addnew VRs
Add new VRs opensthe Include VR dialog. The Include VR dialog
letsyou add one or more new VRsto the selected VPN. See“ Include
VR dialog” (page 62).
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— Remove
Remove removes the selected VPN from the I[P VPN server
database.

Note: This command is only available when the VPN that you have
selected contains no VRs.

— EditIPCoS...
Edit IP CoS opens the Edit Class of Service dialog. The Edit Class
of Service dialog lets you create or modify the IP CoS for the
selected VPN. See“CoS Policy Group dialog” (page 63).

— Help
Help accesses the on-line documentation for the VPN Selected
menul.

VR selected menu
When you select aVR in the provisioning panel, the selected menu contains

the following command:

Remove

Remove opens an Exclude VR dialog. The Exclude VR dialog lets you
remove the selected VR from the containing VPN and from the IP VPN
server database. See “ Exclude VR dialog” (page 75).

Help
Helps accesses the on-line documentation for the VR Selected menu.

Tools menu
The Tools menu contains the following command:

Nodal Provisioning
Nodal Provisioning launches the Nodal Provisioning tool.

Note: Once you launch the Nodal Provisioning tool, you can perform
nodal provisioning tasks. However, beforeyou can apply the service, you
need to activate the provisioning changes in the nodal provisioning
session and then closethe Nodal Provisioning session. If you try to apply
the service before you close the Nodal Provisioning tool, an error
message appears saying that it can not start a provisioning session on the
switch. The error message doesnot informyou that thiserror isgenerated
because the Nodal Provisioning toal is holding the provisioning session.
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Help menu
The Help menu contains the following commands:

*  Help on Window
Help on Window launches the online help information for the IP VPN
Globa Update tool main window.

e About IP-VPN Globa Update
About IP-VPN Globa Update displays the GUI name and version
information.

Hierarchy tree panel
The hierarchy tree panel islocated on theleft of the main window. When you
start the IP VPN global update application, the hierarchy treeis populated
with data retrieved from the IP VPN server database.

The hierarchy tree represents the containment hierarchy for IPVPN. The
containment hierarchy consists of the service provider root and its service
provider customers, customer VPNs and Virtual Routers (VR). You can
expand or collapse items in the hierarchy tree that contain sub-items.

Details panel
The details panel, located to the right of the IP VPN global update main
window, displays the provisioning data for the item that you select in the
hierarchy tree. You can only select oneitem at atime from the hierarchy tree.

All the items in the hierarchy tree have a status which is displayed at the
bottom of the details panel.

Note: No details are displayed on the Service Provider.
You can edit the information displayed in the details panel when the status
displays the message that the item is“Not yet stored in the server database.”
Items that have not yet been stored in the server database are items that are

created through the GUI menu but have not yet been provisioned.

Once information is stored in the database, it cannot be modified.
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Tooltips are available for each entry in the Details area. The tooltip text
displaysthevalid values and rangesfor each entry field. To accessthetooltip,
rest the mouse pointer over the entry field for two seconds.

An Apply command button is located the bottom right of the details panel.
The Apply button is enabled when every required field in the details area
contains avalue.

For additional information see the following sections:

e “Customer details’” (page 44)

e “VPN details’ (page 46)

¢ “VRdetals’ (page51)

Customer details

The customer details panel lets you provision the customer that you have
selected inthehierarchy treeinthe PV PN global update main window.When

you select a customer in the hierarchy tree, the details panel displays the
provisioning information on the selected customer.

The Apply command button in the customer details panel letsyou initiates an
action to store the customer in the IP VPN server database.

For an illustration of the details section, when a customer is selected, seethe
figure “ Customer details area” (page 45)
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Figure 3
Customer details area

Customer fCustomer 1
=F 7

For a summary of the customer properties, their defaults and their valid
values, see the table “ Customer details” (page 46).
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Table 3
Customer details

not the customer has
been stored in the
server database

Property Description Default value Valid value or range

Name The customer name CustomerX, where X | A string containing a
is an automatically minimum of 1 ASCII
incremented integer character. Spaces are

not allowed.
|dentifier The customer X, where X is an An integer value in the
identifier automatically range [0 - 8191]

incremented integer

Status Indicates whether or | N/A N/A

VPN details

The VPN details panel lets you provision the VPN that you have selected in
thehierarchy treeinthe P VPN global update main window. When you select
VPN in the hierarchy tree, the details area of the main window displaysthe

provisioning information for the VPN.

The Apply command button in the VPN details panel initiates an action to
store the VPN inthe IP VPN server database.

For an illustration of the Details section, when a VPN is selected, see the
figure* VPN details area’ (page 47)
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Figure 4
VPN details area

Service Provisioning — IP-VYPN Global Update

For asummary of the VPN properties and their valid values, see the table
“VPN details’ (page 48).
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Table 4
VPN details

Property

Description

Default value

Valid value or range

Name

The VPN name

VPNX, where X is an
automatically
incremented integer

A string containing a
minimum of 1 ASCII
character. Spaces are
not allowed.

Identifier

The VPN identifier

None

A dashed hex string
consisting of 7 pairs of
hex digits. The first 3
digits represent the 3-
octet VPN authority
Organizationally
Unique Identifier and
the following 4 digit
pairs represent the 4
octet VPN index.
Example: 11-12-13-
14-15-16-17

AS Id

The Atonomous
System identifier

[0...65535]

Auto Discovery On

The option to use the
tool in Auto Discovery
mode.

The check box is not
selected

N/A

Private Network
Number

A class C IP address
that is used to form the
class C part of the
default private IP
address for each VR
included in the VPN.
The last octet is
incremented for each
VR included in the
VPN.

0.0.0.0

An |IP address of the
form [0-255].[0-
255].[0-255].0

(Sheet 1 of 2)
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Table 4 (continued)
VPN details

Property

Description

Default value

Valid value or range

Private Network Mask

A network mask that is
used as the default
network mask for the
private IP address for
each VR included in
the VPN.

255.255.255.0

An IP address of the
form [0-255].[0-
255].[0-255].[0-255]
representing a
sequence of
contiguous bits.

Public Network An IP address thatis | 0.0.0.0 An |IP address of the

Number used as the default form [0-255].[0-
public IP address for 255].[0-255].[0-255]
each VR included in
the VPN

Public Network Mask | A network mask that is | 255.255.255.0 An IP address of the

used as the default
network mask for the
public IP address for
each VR included in
the VPN

form [0-255].[0-
255].[0-255].[0-255]
representing a
sequence of
contiguous bits.

User ID A default User No default is supplied. | A string containing 1 to
identifier used to 8 ASCII characters
connect to the
Passport device when
provisioning the VPN

Password A default password No default is supplied. | A string containing 5 to
used to connect to the 8 ASCII characters
Passport device when
provisioning the VPN

Status Indicates whether or | N/A N/A

not the VPN has been
stored in the server
database.

(Sheet 2 of 2)
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Auto Discovery

Selecting the Auto Discovery On check box inthe VPN details panel provides
the option to run the IP VPN Global Update tool in auto discovery mode.
When auto discovery mode is selected, the Passport virtual routers (VRS)
dynamically exchange the IP VPN topology information across VPN sites
every time a customer VR is added or deleted.

All VRsin aVPN must bein either auto discovery mode or in static mode
(not auto discovery mode).

Note: Onceyou create a VPN in static mode, you cannot convert to auto
discovery mode. When you add another VR to a VPN already in static
mode, the Hub and Spoke radio button are disabled and the tool
automatically createsthe new VR in static mode. You need to recreate the
IP VPN in auto discovery mode.

The VPN details provide default values for the VR details panel. There are
two default addressing schemes:

e Private Network Number
e Public Network Number

AS Id

The ASd field lets you specify avalue for the atonomous system identifier
(ASId) of the VPN. All the VRsincluded in the same VPN havethesame AS
Id.

Private Network Number

For the Private Network Number, the VPN details panel requestsaclassC IP
address. When you add aVR to the VPN, aclass D IP addressis provided as
adefault in the VR details panel for each VR. This class D addressis
generated by incrementing the last octet of the VPN’s class C address by one
for each VR added to the VPN. This simple strategy ensures that by default
each VR ina VPN has a unique Private Network Number.

Public Network Number
For the Public Network Number, the VPN form requests an IP address with

the third octet unspecified.
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When you add VRsto the VPN, this |P addressis supplied as the default
Public Network Number value on the VR details panel. You must configure
the Public Network Number for every VR on the same Passport node with the
same class C Public Network Number. This permits class C address
aggregation in the routing tablesfor the device and enables efficient use of the
OSPF routing protocol across the backbone.

VR details
The VR details panel isused to provisionthe VR that you have selected in the

hierarchy tree. The details area of the IP VPN Global Update Tool main
window displays the provisioning data for the VR.

For asummary of the VR properties and their valid values, seethetable“VR
details’ (page 54).

The VR details panel also contains the following items:

» acheck box that lets you enable or disable public |P aggregation on
switch

» acheck box that let you specify that the VR isaroutereflector inthe VPN

» radio buttonsthat let you select whether the customer VR isahub or
spoke

If you select Enable Public IP Aggregation, you enable public | P aggregation
on switch.

If you select the auto discovery mode, and al so specify that the VR isaroute
reflector inthe VPN, the Hub radio button isautomatically selected, and is set
to read-only mode.

If you do not specify that the VR isaroute reflector, then you need to specify
that the customer VR is either a hub or spoke. Based on the topology
scenarios supported by the IP VPN Global Update tool, you have the
following options;

»  fully-meshed topology
In afully-meshed topology, all the customer VRs are hubs. The
vpnPeering Topology attributeis set to hub on all the customer VRs
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belonging to the VPN. Consequently, dynamic IBGP peers are set up to
all other VPN sites. | P routes advertised by BGP instances of all VPN
sites are known to all other VPN sites.

»  dtar topology
In a star topology, only one customer VR is specified as a hub and route
reflector. All other customer VRs are spokes, and clients of the route
reflector.

»  dtar topology with two route reflectors
In a star topology with two route reflectors, two customer VRs are
specified as route reflectors and hubs. For each VR specified as aroute
reflector and hub, all the other VRs areits clients. The VRs not specified
as route reflectors and hubs are spokes.

The Apply command button in the VR details panel opens a Confirm
Provisioning Options dialog. For a description of the Confirm Provisioning
dialog, see “ Confirm Provisioning Options dialog” (page 59). The action to
create and include the new VR in the VPN is only initiated when you click
OK in the Confirm Provisioning Options dialog.

For anillustration of the VR details panel, see the figure “VR details panel”
(page 53).
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Figure 5
VR details panel

Service Provisioning — IP-V¥PN Global Update
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Table 5
VR details
Property Description Default value Valid value or range
Switch Name The name of the No default value. The switch name must
device on which the be present in the
VR is provisioned HGDS group.
Name The VR name The VPN to which the | A string containing 1 to

VR belongs is used as
the default VR name.

8 ASCII characters.
Spaces are not
allowed.

Private Network
Number

The Private IP address
for the VR.

The Private Network
Number specified for
the VPN with the last
octet incremented with
each VR included in
the VPN.

An IP address of the
form [0-255].[0-
255].[0-255].[0-255]

Private Network Mask

A network mask of the
private IP address for
the VR.

The Private Network
Mask specified for the
VPN.

An IP address of the
form [0-255].[0-
255].[0-255].[0-255]
representing a
sequence of
contiguous bits.

Public Network
Number

An public IP address
for the VR.

The Public Network
Number specified for
the VPN.

An IP address of the
form [0-255].[0-
255].[0-255].[0-255]

Public Network Mask

A network mask of the
public IP address for
the VR.

The Public Network
Mask specified for the
VPN.

An IP address of the
form [0-255].[0-
255].[0-255].[0-255]
representing a
sequence of
contiguous bits.

Enable Public IP
Aggregation

Indicates whether or
not public IP
aggregation on switch
is enabled or disabled

No default value

Yes or No as indicated
by the check box.

(Sheet 1 of 2)
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Table 5 (continued)
VR details

Property

Description

Default value

Valid value or range

Route Reflector

Indicates whether or
not the VR is a route
reflector in the VPN.

No default value

Yes or No, as
indicated by the check
box.

Hub Selects the customer | Hub, when route Yes or No, as
VR as a hub in the reflector is selected indicated by the radio
VPN button.

Spoke Selects the customer | No Yes or No, as

VR as a spoke in the
VPN

indicated by the radio
button.

Password - Use

Indicates whether or

By default, the “Use

The “Use Defaults”

Defaults not to use the default | Defaults” option is check box may be
userid and password | selected. selected or
values supplied in the unselected.
VPN.

User ID A User Identifier to No default is supplied. | A string containing 1 to
connect to the 8 ASCII characters.
Passport device when
provisioning the VR.

Password A password used to No default is supplied | A string containing 5to
connect to the 8 ASCII characters.
Passport device when
provisioning the VR.

Status Indicates whether or | N/A N/A

not the VPN has been
stored in the server
database.

(Sheet 2 of 2)

IP VPN global update tool GUI dialogs
ThelP VPN global update tool user interface generatesthe following dialogs:

“Options dialog” (page 56)

“Confirm Provisioning Options dialog” (page 59)
“Include VR dialog” (page 62)
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e “CoS Policy Group dialog” (page 63)
e “Add New CoS Policy dialog” (page 66)
* “Maodify CoS Policy dialog” (page 69)
*  “New Flow Classification dialog” (page 71)
* “Modify Flow Classification dialog” (page 73)
* “Exclude VR didog” (page 75)
e “Error and Message dialogs’ (page 76)
* “Progressdialogs’ (page 77)
Options dialog
You access the Options editor dialog by clicking Options... in the Edit menu
of the IP VPN global update tool main window. The Options dialog contains
asingle provisioning tab where provisioning options may be edited. The

provisioning tab provides options for selecting a device view from which to
start provisioning and a device view for saving provisioning data.

The Confirm Provisioning Options dialog contains similar options when an
action resulting in on-switch provisioning is performed. The default values
shown in the Confirm Provisioning Options dialog are those specified int he
provisioning tab of the Options dialog. See “ Confirm Provisioning Options
dialog” (page 59).

For anillustration of the Options dialog, see the figure “ Options dialog’
(page 57).
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Figure 6
Options dialog

For a description of the parts of the Optionsdialog, seethefollowing sections:
« “Start From Provisioning View” (page 57)

e “Save To Provisioning View” (page 58)

+ “Command buttons’ (page 58)

Start From Provisioning View

The Start From Provisioning View section provides the options for selecting
adevice view from which deferred to start provisioning. You can select from
the following options by clicking the radio button:

e Current View
Current View isthe current configuration and operating parameters of the
device.

e Committed View
Committed View isthe saved version of the current view that the devices
uses when it resets or restarts.
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+ Edit View
Edit View isthe provisioning data which has been loaded into memory
so that it can be modified.

*  Named View
Named View isaview stored in filewith auser-specified filename. When
you click Named View, the text box is activated so you can enter thefile
name of the view that you want to select. A valid file nameisany ASCI|
string one to 31 characters long.

Save To Provisioning View
The Save To Provisioning View section letsyou specify afilenamefor saving

the provisioning data. When you click Named View you activate the text field.
You must specify afilenamein thetext field. A valid filenameisany ASCII
string one to 31 characters long.

Note: If you leave the Named View text field blank, the Apply and OK
command buttons remain disabled.

The Save To Provisioning View areaincludes the following command
buttons:

* Activate View
Activate View activatesthe view that has been modified and saved during
aprovisioning session.

e Commit View
Commit View commitsthe saved view. When you click the Activate view
check box, the Commit view check box is activated so that you can
commit the saved view.

Command buttons
The Options dialog has the following command buttons:

*  Apply
Apply applies the selected options.
« OK
OK applies the selected options and closes the Options dialog.

* Cancel
Cancel cancels the changes that you have made and closes the Options
dialog.
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* Hep
Help launches the online help information for the Options dialog.

Confirm Provisioning Options dialog
When you perform an action that resultsin on-switch provisioning, the
Confirm Provisioning Options dialog opens to let you confirm or edit your
provisioning options. The contents of the Confirm Provisioning Options
dialog correspond to those found in the Options dialog. The default values
shown inthe Confirm Provisioning Optionsdialog are those that you selected
in the Options dialog. See “Options dialog” (page 56).

The Confirm Provisioning Options dialog opens when you perform the
following actions:

* includeanew VRinaVPN

* excludeaVRfromaVPN

 apply IPCoStoaVPN

After performing an on-switch action, provisioning the device proceedswhen
you click OK in the Confirm Provisioning Options dialog.

For anillustration of the Confirm Provisioning Options dialog, seethe figure
“Confirm Provisioning Options dialog” (page 60).
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Figure 7
Confirm Provisioning Options dialog
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For a description of the parts of the Confirm Provisioning dialog, see the
following sections:

e “Start From Provisioning View” (page 60)
e “Save To Provisioning View” (page 61)
e “Command buttons’ (page 61)

Start From Provisioning View
The Start From Provisioning View section provides the options for selecting

a device view from which to start provisioning. The default is the view that
you selected in the Options dial og.

You can select from the following options by clicking the radio button:

*  Current View
Current View isthe current configuration and operating parameters of the
device.
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Committed View
Committed View isthe saved version of the current view that the devices
uses when it resets or restarts.

» Edit View
Edit View isthe provisioned data currently being modified.

*  Named View
Named View isaview stored in filewith auser-specified filename. When
you click Named View, the text box is activated so you can enter the
filename of the view that you want to select. A valid file nameis any
ASCII string that is one to 31 characters long.

Save To Provisioning View
The Save To Provisioning View section letsyou specify afilenamefor saving

the provisioning data. By default, the file name that you specified in the
Options dialog appears in the Named View field.

The Save To Provisioning View areaincludes the following command
buttons:

* Activate view
Activate view activates the saved view.

o Commit view
Commit view commitsthe saved view. When you click the Activate view
check box, the Commit view check box is activated so that you can
commit the saved view.

Command buttons
The Confirm Provisioning Options dialog has the following command

buttons:

« OK
OK causes the action which opened the Confirm Provisioning Options
dialog to proceed by sending the appropriate requests to the IP VPN
server. The server uses the specified provisioning options to begin
provisioning the appropriate device or devices.

* Cancel
Cancel cancels the operation which opened the Confirm Provisioning
dialog.
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e Help
Help launches the online help information for the Confirm Provisioning
Options dialog.

Include VR dialog
The Include VR dialog opens when you select a VPN in the hierarchy treein
the PV PN global update main window and then select Add new VR from the
VPN selected menu. Thelnclude VR dialog letsyou create and include anew
VRintheVPN.

For an illustration of the Include VR dialog, see the figure “Include VR
dialog” (page 62).

Figure 8
Include VR dialog

—| includevR__|

Create and Include |1 MNew YRS

DK| Cancel| Help|

The Include VR dialog contains the following:
e “Create and Include New VRs text field” (page 62)
e “Command buttons’ (page 62)

Create and Include New VRs text field
The Create and Include New VRstext field lets you specify the number of

new VRsto create and include in the VPN. The default value is one.

Command buttons
The Include VR diaog has the following command buttons

« OK
OK adds the number of VRs that you have specified in the text field to
the VPN. Each VR is created locally in the GUI. To store the
provisioning datain the IP VPN server database and to create the VRs
you must click Apply inthe IP VPN Global Update Tool window.
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+ Cancd
Cancel cancelsthe Include VR operation.
* Help

Help launches the online help for the Include VR dialog.

CoS Policy Group dialog
The CoS Palicy Group dialog opens when you select Edit IP CoS... from the
VPN Selected menu. You can provision the policy group, policies, and flow
classificationsthat definethe IP Class of Servicefor the VPN. A policy group
contains zero or more policies and each policy contains zero or more flow
classifications.

Provisioning I P CoS involves provisioning a single policy group for a VPN.
Thispolicy group appliesacrossall VRsinthat VPN. When aVR isadded to
a VPN with IP CoS already configured, the same policy group is applied to

thenew VR.

The IP CoS provisioning data is stored in the off-switch database on the IP
VPN server. When the Edit Class of Servicedialog isopenfor aVPN on
which IP CoS has already been provisioned, the IP CoS data stored on the
server isretrieved and displayed in thedialog. If the |P CoS data has not been
previously provisioned, the dialog displays default values.

For anillustration of the CoS Policy Group dial og, seethe figure*“ CoS Policy
Group dialog” (page 64).
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Figure 9
CoS Policy Group dialog

CoS Policy Group

The CoS Policy Group dialog, has the following sections:
* “Policy Group field” (page 65)

e “TosMarking panel” (page 65)

e “ToSMask field” (page 65)

e “Policieslist” (page 65)

e “Command buttons’ (page 66)
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Policy Group field

The Policy Group is the name of the policy group being provisioned. The
default valueis PG_<VPN name>. Valid values are a string contai ning oneto
20 ASCII characters. Spaces are not allowed.

Tos Marking panel
The ToS Marking panel is used to provision ToS marking for the policy

group. It has the following sections:

»  Enable ToSmarking for the CoS Index section provides check booksthat
let you enable or disable the ToS marking for any of the CoSindices. By
default, ToS marking is disabled for al CoS indices.

* ToS Vauefieldslets you specify a ToS value for each CoS index. Each
ToS value is used with the ToS mask to determine the value of the ToS
byte. The value fields can be blank or may contain a hexadecimal value
from 00-FF. By default, the ToS value fields are blank.

ToS Mask field

The ToS Mask is the ToS bit mask that is used to determine the byte value.
The Tos Mask field may be blank or contain any hexadecimal value from 00-
FF.

Policies list
The Policieslist contains alist of the palicies that have been added to the
policy group. By default, the Palicieslist is empty.

The contents of the list are modified using the following command buttons
found to the right of the Policieslist.

* New..
New... opens an Add New CoS Policy dialog to add a new policy to the
policy group. The new policy isadded to the Policieslist. See “Add New
CoS Policy dialog” (page 66).

*  Maodify...
Modify... opens a Modify CoS Policy dialog to edit the policy that is
selected in the Policieslist. The Modify... button is enabled only when a
policy is selected from thelist. See “Modify CoS Policy dialog”

(page 69)
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 Dedlete...

Delete... removes the policy that is selected in the Policies list from the
list.

Command buttons
The Edit Class of Service dialog has the follow command buttons:

* Apply
Apply opensa Confirm Provisioning Options dial og that letsyou initiate
the action to store the IP CoS provisioning datain the IP VPN Server
database. The IP CoSis provisioned for any VRs contained in the VPN.

« Cance

Cancel erasesthe IP Cos provisioning data that you have entered and
cancels the operation.

* Hep
Help launches the online help information for the CoS Policy Group
diaog.

Add New CoS Policy dialog
The Add New CoS Policy dialog opens when you select New... in the Edit
Class of Servicedialog. The Add New CoS Policy dialog lets you provision
apolicy under apolicy group.

For anillustration of the Add New CoS Policy dialog, see the figure “Add
New CoS Policy dialog” (page 67).
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Figure 10
Add New CoS Policy dialog

Add New CoS Policy

See the following for a description of the parts of the Add New CoS Policy
dialog:

« “Policy field” (page 67)

e “CoSIndex field” (page 67)

 “TosMap field” (page 68)

* “Fow Classification list” (page 68)

e “Command buttons’ (page 68)

Policy field

The Policy field specifies the name of the policy being provisioned. You can
enter a string containing 1 to 20 ASCII characters. Spaces are not allowed.
The default is Policy_ <VPN name>_X, where X isincremented with the
number of policiesin the policy group.

CoS Index field
The CoSIndex field identifiesthe class of service treatment a packet receives

if thispolicy applies. Valid valuesis aninteger in the range [0-3]. The default
vaueisO.
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Tos Map field
The ToS Map field contains alist of ToS byte values used to map incoming

packets under the same policy. Valid ToS values are a string of hexidecimals
intherange [00-FF]. Each value must be separated by aspace. By default, the
ToS Map is empty.

Flow Classification list
The Flow Classification list contains alist of flow classifications that have

been added to the policy. Command buttons to the right of the Flow
Classification list let you modify the contents of the list:

* New..
New... opens an Add Flow Classification dialog to add a new flow
classification to the policy. When you add a new flow classification, it
appears in the Flow Classification list.

e Modify...
Modify... opens aModify Flow Classification dialog to edit the flow
classificationthat isselected inthe Flow Classification list. The Modify...
button is enabled when aflow classification is selected in the Flow
Classification list.

 Delete...
Delete... removes the flow classification that is selected in the Flow
Classification list. The Delete button is only enabled when a flow
classification is selected in the list.

Command buttons
The Add New CoS Policy dialog contains the following command buttons:
+ OK

OK adds the new Cos Palicy to the policy group.

e Cancel
Cancel cancels the operation.

e Help

Help launches the online help information for the Add New CoS Policy
diaog.
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Modify CoS Policy dialog
The Modify CoS Policy dialog opens when you select a policy in the Edit
Class of Service dialog and then select the Modify... command button. The
Modify CoS Palicy dialog lets you modify the provisioning data for the
policy.

For an illustration of the Modify CoS Policy diaog, see the figure “Modify
CoS Policy dialog” (page 69).

Figure 11
Modify CoS Policy dialog

Modify CoS Policy

See the following for a description of the parts of the Modify CoS Policy
dialog:

“Policy field” (page 70)

“CoS Index field” (page 70)
“TosMap field” (page 70)

“Flow Classification list” (page 70)
“Command buttons” (page 71)
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Policy field

The Palicy field specifies the name of the policy being provisioned. You can
enter a string containing 1 to 20 ASCI| characters. Spaces are not allowed.
The default is Policy_ <VPN name>_X, where X isincremented with the
number of policiesin the policy group.

CoS Index field
The CoSIndex field identifiesthe class of servicetreatment a packet receives

if thispolicy applies. Valid valuesis an integer in the range [0-3]. The default
value is zero.

Tos Map field
The ToS Map field contains alist of ToS byte values used to map incoming

packets under the same policy. Valid ToS values are a string of hexidecimals
intherange [00-FF]. Each value must be separated by a space. By default, the
ToS Map is empty.

Flow Classification list
The Flow Classification list contains alist of flow classifications that have

been added to the policy. Command buttons to the right of the Flow
Classification list let you modify the contents of the list:

* New...
New... opens an Add Flow Classification dialog to add a new flow
classification to the policy. When you add a new flow classification, it
appears in the Flow Classification list.

*  Modify...
Modify... opens aModify Flow Classification dialog to edit the flow
classification that is selected in the Flow Classification list. The
Modify...button is enabled when a flow classification is selected in the
Flow Classification list.

 De€ete...
Delete... removes the flow classification that is selected in the Flow
Classification list. The Delete button is only enabled when aflow
classification is selected in the list.
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Command buttons
The Modify CoS Policy dialog contains the following command buttons:

« OK
OK updates the provisioning data for the policy that you selected in the
Edit Class of Service dialog.

* Cancel
Cancel cancels the operation.

* Hdp
Help launches the online help information for the Modify CoS Policy
diaog.

New Flow Classification dialog
The New Flow Classification dialog openswhen you click New... in the Add
New CoS Policy dialog or in the Modify CoS Policy dialog. The New Flow
Classification dialog lets you provision aflow classification for a policy.

For anillustration of the New Flow Classification dialog, seethefigure“New
Flow Classification dialog” (page 71).

Figure 12
New Flow Classification dialog

r New Flow Classification _I

Flow Classification Identifier:

Frotocol: TCF i
Paort: Fi
Prefic: 0.0.0.0

Frefix Length: Fi
ﬂ Canicel @

For the parts of the New Flow Classification, see the following sections:
* “Fow Classification Identifier field” (page 72)
*  “Protocol field” (page 72)
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e “Portfield” (page 72)
“Prefix field” (page 72)
“Prefix length field” (page 72)

“Command buttons’ (page 72)

Flow Classification Identifier field
The Flow Classification Identifier field lets you enter aflow classification

identification. It isan integer in the range [0-1023]. By default it isan integer
that is incremented with the number of flow classificationsin the policy
group.

Protocol field
The protocol field lets you specify the layer 4 protocol used to distinguish

incoming packets under the same policy. You can select from adrop-down list
containing the following protocols; TCP, UDP or ICMP. The default is TCP.

Port field

The port field lets you specify the single layer 4 port number used to
distinguish incoming packets under the same policy. The valid rangeis an
integer in the range [0-65535]. The default value is 0.

Prefix field

Prefix isan | P address used to match incoming packets under the same policy.
An IP addressiis of the form [0-255].[0-255].[0-255].[0-255]. 0.0.0.0 is the
defaullt.

Prefix length field
Prefix length isthe number of most significant bitsin the Prefix that are used

to match the 1P address of anincoming packet. Valid valuesareintegersinthe
range [0-32]. The default valueis 0.

Command buttons
The dialog has the following command buttons:

« OK
OK adds the flow classification to the policy group.
* Cancel

Cancel cancelsthe add a new flow classification operation.
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e Help
Help launches the online help information for the New Flow
Classification dialog.

Modify Flow Classification dialog
TheModify Flow Classification dialog openswhen you select Modify... inthe
Add New CoS Policy dialog or in the Modify CoS Poalicy dialog. You can
modify the flow classification for a policy using the Modify Flow
Classification dialog.

For anillustration of the modify flow classification dialog, see“ Modify Flow
Classification dialog” (page 73).

Figure 13
Modify Flow Classification dialog

I Modify Flow Classiﬁcation
Flow Classification Identifier: |1

Frotocol: TCF 4
Fort; 5
Frefix, 0.0.0.0

Frefix Length; E
ﬂ Cancel @

The Modify Flow Classification dialog contains the same fields as the Add
Flow Classification. See the following sections:

* “Fow Classification identifier field” (page 74)
*  “Protocol field” (page 74)

e “Portfield” (page 74)

*  “Prefix field” (page 74)

e “Prefix length field” (page 74)

e “Command buttons’ (page 74)
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Flow Classification identifier field
The Flow Classification Identifier field lets you enter aflow classification

identification. It isan integer in therange [0-1023]. By default it isan integer
that is incremented with the number of flow classificationsin the policy
group.

Protocol field
The Protocol field lets you specify the layer 4 protocol used to distinguish

incoming packets under the same policy. You can select from adrop-down list
containing the following protocols; TCP, UDP or ICMP. The default is TCP.

Port field
The port field lets you specify the single layer 4 port number used to

distinguish incoming packets under the same policy. The valid range is an
integer in the range [0-65535]. The default value is 0.

Prefix field
Prefix isan | P address used to match incoming packets under the same policy.

An |P addressis of the form [0-255].[0-255].[0-255].[0-255]. 0.0.0.0 is the
default.

Prefix length field
Prefix length isthe number of most significant bitsin the Prefix that are used

to match the IP address of anincoming packet. Valid values areintegersinthe
range [0-32]. The default valueis 0.

Command buttons
The dialog has the following command buttons:

e OK
OK updates the provisioning data for the flow classification that was
selected in the Add New CoS Policy dialog.

* Cancel
Cancel cancels the modify flow classification operation.
* Hep

Help launches the online help for the Modify Flow Classification dialog.
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Exclude VR dialog
The Exclude VR dialog opens when you select a VR in the IP VPN Global
Update Tool window and then select Remove from the VR selected menu.
The Exclude VR dialog lets you remove a VR from the VPN.

Note: You can only access the VRs that were added to a VPN by using
the IP VPN global update tool.

For an illustration of the Exclude VR dialog, see the figure “Exclude VR
dialog” (page 75).

Figure 14
Exclude VR dialog

=l Bxcueevk |

e Exclude WR from YPH

) Exclude WR. from VFMN and Delete YR component

ﬂ Cancel %

The Exclude VR dialog contains the following options:

e Exclude VR from VPN
The Exclude VR from VPN radio button excludesthe VR from the VPN
that containsit. The VR component is not deleted but it isno longer part
of any VPN.

» Exclude VR from VPN and Delete VR component
The Exclude VR from VPN and Delete VR component radio button
excludes the VR from the VPN that containsit and deletes the VR
component from the device on which it has been provisioned.
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The Exclude VR dialog contains the following command buttons:

OK

OK opens the Confirm Provisioning Options dialog. See “ Confirm
Provisioning Options dialog” (page 59). The exclude VR operation
proceeds when you click OK in the Confirm Provisioning Options
dialog.

Cancel
Cancel cancels the exclude VR operation.

Help
Help launches the online help information for the Exclude VR dialog.

Error and Message dialogs
Information and errors are displayed in message dialogs. Message dialogs
contain an OK button. When you select the OK button, the message dialog
closes.

An error message dialog opens in the following situations:

IP VPN server is not running while the tool is connecting. The Message
dialog openswith the message “ Shutting down...Unableto connect to the
server... IP VPN Server not responding.

IP VPN server shuts down while thetool is connected. The dialog opens
with the message “ The connection to the IP VPN Server has been lost.
Shutting down...”.

Failureto obtain alist of devicesfrom HGDS. The message dial og opens
with the message “ Unable to retrieve the device names. Reason...”. The
reason is that reported by the server.

Invalid data has been entered in any entry field and an attempt is made to
apply the provisioning data. A message dialog opens indicating which
field isinvalid and what the valid values are.

Failure of any provisioning operation onthedevice, including check prov
failures. The device error text is reported verbatim in a message dialog

See the figure “ Example of amessage dialog” (page 77) for anillustration of
the message dial og that opens when you cannot connect to the server.
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Figure 15
Example of a message dialog

—| Message

. Shuttng down, ..
J Unable to connect to the server with hostmame localhost using port 6800,
Reason: Unable to connect to [P WPM Server: IP WP Server not responding.

o |

Log files
A log file may be specifiedinthe IP_VPN_Client.txt configuration file using
the following syntax:

log_file=<fil ename>
where:
<f i | enane>isthefully specified path and filenamefor thelog file. The path

to the filename must exist for logging to be recorded in thefile. Thefollowing
items are recorded in the log file:

» dateinformation, including information about the state of the connection
to the IP VPN server

» records of any configuration operations initiated by the user
e textthatisdisplayedin any error message dialogs

Progress dialogs
A progress dialog opens when the |P VPN global update tool communicates
with the IP VPN server. The dialog indicates what action is being performed
and its progress. When the action is complete, the progress dialog closes.
Progress dialogs open in the following situations:

* |PVPN global update GUI start-up while the GUI connectsto the server
and retrieves data stored in the server database

e applying or removing a customer

e applying or removing aVPN
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» applying or excludinga VR
* applying IP CoS

Seethefigure* Example of aprogressdialog” (page 78) for an example of the
progress dialog that opens when you connect to the server.

Figure 16
Example of a progress dialog
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Chapter 5
Using the IP VPN global update tool GUI

ATTENTION If you have upgraded to Preside MDM Release 14.3, use the
IP VPN Service Provisioning tool to configure RFC 2764
VPNSs with auto-discovery enabled. See 241-6001-616
Preside MDM IP VPN Service Configuration User Guide.
Further information can be found the the 14.3 Release
Supplement.

For the proceduresto use the IP VPN global update tool GUI, see the
following sections:

e “Selecting adeviceview for provisioning, and saving provisioning data”
(page 79)

*  “Service provider selected menu procedures’ (page 80)

e “Customer selected menu procedures’ (page 81)

*  “VPN selected menu procedures’ (page 83)

*  “VR selected menu procedures’ (page 90)

*  “Creating a new customer VPN” (page 91)

Selecting a device view for provisioning, and saving

provisioning data
The Options dialog provides options to select a device view from which to
start provisioning, and to specify the file name to save the provisioning data.
You can specify or change the provisioning options at any time during your
provisioning session.
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Note: For any action that resultsin on-switch provisioning, the Confirm
Provisioning Options dialog opens before provisioning proceeds. If you
have already specified the provisioning options, the default values
displayed in the Confirm Provisioning Options dialog correspond to the
values that you specified in the Options dialog. The Confirm
Provisioning Options dialog lets you confirm or edit your selections.

In the IP VPN global update main window, select Edit.
From the Edit menu, select Options...

The Options dialog opens. See “Options dialog” (page 56) for a
description of the dialog.

In the Start From Provisioning View area, select a device view from which
to start provisioning. You have see “Start From Provisioning View”
(page 60).

To save the provisioning data to a file, in the Save To Provisioning View
area click Named View and enter the appropriate provisioning data file
information in the Named View field. See “Save To Provisioning View”

(page 61).

To activate the modified view, click Activate view.

The Commit view is enabled.

To commit the view, click Commit view.

To apply the selected options, click Apply.

To apply the selected options and close the Options dialog, click OK.

To cancel the selections and close the Options dialog, click Cancel.

Service provider selected menu procedures

From the service provider selected menu, you can add a new customer to the
service provider. See “Adding anew customer” (page 80).

Adding a new customer

1

Launch the IP VPN global update tool.

The tool opens with all customer and associated VPN data loaded in the
hierarchy.

In the hierarchy tree, click the mouse menu button on Service Provider.

From the pop-up menu, select Add new customer.
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The new customer appears at the bottom of the hierarchy with the name
Customer/CUSTOMER<n>.

4 Inthe hierarchy, select the newly created customer.

The Details panel is populated with the default information for the
customer.

5 In the Details panel, complete the following:
a. Inthe Customer Name field, enter a valid customer name.
b. Inthe Customer Identifier field, enter a valid customer identifier.

See “Customer details” (page 46) for information on valid values and
ranges.

The Apply button is enabled when all fields are filled in.

Note: You can obtain tooltip information on the fields by placing the
mouse pointer over the field.

6 Click Apply to add the customer to the server database.

If the data that you have entered is valid, a create customer progress
dialog opens showing the progress of the Add new customer command.
Click OK. If the operation succeeds, the Apply button is disabled and the
Customer status section of the Details panel indicates that the details are
“stored in the server database”. The hierarchy tree is updated to contain
the new customer.

If any of the data entered in the Details panel are invalid, an error dialog
opens indicating which field is invalid and why. Return to step 5 to enter
valid data.

Customer selected menu procedures

From the customer selected menu, you can perform the following customer-
related procedures:

* “Removing acustomer” (page 81)
e “Adding anew VPN to a customer” (page 82)

Removing a customer
You can remove a customer from the service provider.

Note: The Remove command is only available when the selected
customer has no VPNs.
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1

In the IP VPN global update tool main window, expand the hierarchy to
display the customer that you want to remove.

Click the mouse menu button on the Customer that you want to remove
from the hierarchy.

From the pop-up menu, select Remove.

A Delete Customer Progress dialog appears telling you that the customer
is being deleted.

Click OK.

The customer is removed from under Service Provider in the hierarchy
tree.

Adding a new VPN to a customer
You can add anew VPN to a customer.

In the IP VPN Global Update Tool main window, expand the hierarchy to
display the customer to which you want to add a VPN.

Click the mouse menu button on the customer to which you want to add
a VPN.

From the pop-up menu, select Add new VPN.

A new VPN appears under the selected customer.

In the hierarchy, select the VPN that you have created.

The Details panel displays the default information for the VPN.

Edit the VPN Name and VPN Identifier fields in the VPN Details panel if
required.

The VPN identifier is a hex string consisting of 7 pairs of hex digits. The
first three digits represent the 3-octet VPN authority Organizationally
Unique Identifier and the following four digit pairs represent the 4-octet
VPN index.

Note: You can access tooltips on the valid values and ranges by placing
your mouse pointer over a field.

To use the tool in auto discovery mode, select the Auto Discovery On
check box.

Edit the remaining fields in the VPN Details panel, if required.

See “VPN details” (page 48) for a description of the fields and the valid
values and ranges.
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Data common to all VRs in the VPN can be configured here, and this data
is used to provide defaults in the VR details panel for VRs that may later
be included in the VPN. As a default value, the last octet of the private
network number is incremented for each VR that is included in the
network. The private network mask, public network number, and public
network mask values are used unchanged as default values for VRs that
are included in the VPN. The default userid and password values can also
be applied to VRs included in this VPN.

The Apply button is enabled when all the fields are filled in. See “VPN
details” (page 48) for a description of the fields and the valid values and
ranges.

8 Click Apply to add the VPN information to the server database.
One of the following occurs:

« Ifall of the data entered in the Details fields is valid, a progress dialog
opens showing the progress of the Add new VPN command. When
the operation is successfully completed, Apply is disabled and the
Status changes to “Stored in the server database”. The customer in
the hierarchy tree is updated with the VPN.

« Ifthe data entered in any of the fields is invalid, a message dialog
appears indicating which field is invalid and why. Correct the invalid
data and click Apply.

« Ifanerror occurs while the operation is in progress, a message dialog
opens indicating the error, and the Add new VPN operation ends.

VPN selected menu procedures
From the VPN Selected menu, you can perform the following procedures:

 “AddingaVRtoaVPN” (page 83)
* “Removing aVPN" (page 85)
*  “Applying IP CoSto aVPN”" (page 86)

Adding a VR to a VPN
You can add VRsto a VPN. This procedure describes adding VRs to an
existing VPN. See“ Creating a new customer VPN (page 91) for the
procedure to include VRsin anew VPN.

1 Inthe IP VPN global update tool window, expand the hierarchy to display
the VPN to which the new VR is to be added.
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N

Click the mouse menu button on the VPN to which you want to add a VR.
3 From the pop-up menu, select Add new VRs.
The Include VR dialog opens.

4 In the Create and Include New VRs text field, enter the number of VRs
that you want to include in the VPN.

5 Click OK.
The VRs are added to the selected VPN.
6  From the hierarchy tree, select the first of the newly added VRs

The default information on the VR appears in the fields in the Details
panel.

7  Edit the default information contained in the fields (Switch Name, VR
Name, Private Network Number, Private Network Mask, Public Network
Number, Public Network Mask, Enable Public IP Aggregation, and Route
Reflector), if required, and enter a valid User ID and Password. See “VR
details” (page 54) for a description of the fields and their valid values and
ranges.

Note 1: The “Switch Name” combo box contains a drop down list of all
possible device names.

Note 2: You can access tooltips that provide valid values and ranges for
the field by placing your mouse pointer over the field.

8 Ifthe VPN containing the VR being added has Auto Discovery set,
proceed to step 9.

If the VPN containing the VR being added does not have Auto Discovery
set, proceed to step 10.

9  Complete one of the following steps:

» select Route Reflector. If you select Route Reflector, the hub radio
button is automatically selected and set to read-only mode.

« do not select Route Reflector. If you do not select Route Reflector
then you must select either hub or spoke.

The Apply button is enabled when you have filled in all the fields.
10 Click Apply to add the VPN to the server database.

If any of the data entered in the details panel is invalid, a message dialog
opens indicating which field is invalid and why. Correct the invalid data
and Click Apply again.
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11

12

13

14
15

16

If all of the data is valid, a Confirm Provisioning Options dialog opens. See
“Confirm Provisioning Options dialog” (page 59).

To select a device view from which to start provisioning, in the Start From
Provisioning View area, select a device view.

To specify a file name to save the provisioning view, in the Save To
Provisioning View area, click the Named View radio button and enter a
name in the text field.

To activate the saved view, click Activate view.
Commit view is activated.

To commit the view, click Commit view.

Click OK.

A progress dialog appears showing the progress of the create and include
VR command.

If the operation is successful, the Apply button is disabled and the status
message in the details panel changes to “Stored in the server database”.

If an error occurs while the operation is in progress, a message dialog
opens that indicates the error. The operation stops and the tool
disconnects for any devices that it is connected to.

Repeat steps 6 to 14 for each VR that you added to the VPN.

Note: When you display the data input fields for the next VR that you
create, the Private Network Number is automatically incremented.

Removing a VPN
You can remove a VPN from a customer.

Note: The Remove command isenabled only if the VPN doesnot contain
VRs.

In the IP VPN global update tool main window, expand the hierarchy to
display the VPN that you want to remove.

Click the mouse menu button on the VPN that you want to remove and
select Remove.

A Delete VPN Progress window appears.

The VPN is no longer listed under the customer.
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Applying IP CoS to a VPN
You can provision the policy group, policies and flow classifications that
definethe |P CoS for the VPN. See the following for the procedures to apply
IP CoSto the VPN or to change the IP CoS configured for the VPN:

“Opening the Edit Class of Service dialog” (page 86).

“Provisioning the CoS policy group” (page 86).

Adding modifying, or deleting policies.

— Toadd apolicy, see “Adding apolicy” (page 87)

— To modify an existing policy in the policy group, see “Modifying a
policy” (page 87)

— Todelete apolicy from apolicy group, see “Deleting a policy”
(page 88).

Adding, modifying, or deleting flow classificationsin a policy

— toadd aflow classification, see “Adding aflow classification”
(page 88)

— tomodify aflow classification, see “Modifying aflow
classification” (page 89)

— todeleteaflow classification, see “ Deleting aflow classification”
(page 89).

Applying the provisioning changes. See “Applying | P CoS provisioning
changes’ (page 90).

Openlng the Edit Class of Service dialog

In the IP VPN global update tool main window, expand the hierarchy to
display the VPN to which you want to apply the IP CoS.

Click the mouse menu button on the VPN.
From the pop-up menu, select Edit IP CoS...

The Edit Class of Service dialog opens. See “CoS Policy Group dialog”
(page 63).

Provisioning the CoS policy group

1

In the Edit Class of Service dialog fields, as required, enter a Policy Group
name, set each CoS Index check box, provide a ToS Marking value and
enter a ToS Mask.
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2 Proceed to one of the following procedures:

To apply the changes, see “Applying IP CoS provisioning changes”
(page 90)

To add a policy to the policy group, see “Adding a policy” (page 87).
To modify a policy in the policy group, see “Modifying a policy” (page 87).
To delete a policy from the policy group, see “Deleting a policy” (page 88).
Adding a policy
You can add a new policy to the policy group
1 Inthe Edit Class of Service dialog, click New...

The Add New CoS Policy dialog opens. See “Add New CoS Policy dialog”
(page 66).

2 Edit the Policy, CoS Index, and ToS Map fields, as required.
3 Proceed to one of the following procedures.

Click OK and proceed to “Applying IP CoS provisioning changes”
(page 90) to apply the changes.

Note: If any of the data entered in thefieldsisinvalid, a message dialog
opensindicating which field isinvalid and why. Correct the data and
click OK again.

To add a flow classification, see “Adding a flow classification” (page 88).

To modify a flow classification, see “Modifying a flow classification”
(page 89).

To delete a flow classification, see “Deleting a flow classification”
(page 89).

Modifying a policy
You can edit a policy in the policy group from the Edit Class of Service
dialog.

1 From the Policies list in the Edit Class of Service dialog, select the policy
that you want to modify
2 Click Modify...

The Modify CoS Policy dialog opens. See “Modify CoS Policy dialog”
(page 69).
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Edit the Policy, CoS Index, and ToS Map fields, as required.
Proceed to one of the following procedures:

Click OK to close the Modify CoS Policy dialog and proceed to “Applying
IP CoS provisioning changes” (page 90).

Note: If any of the data entered in the fields is invalid, a message dialog
opens indicating which field is invalid and why. Correct the data and click
OK again.

To add a flow classification to the policy, see “Adding a flow classification”
(page 88).

To modify a flow classification, see “Modifying a flow classification”
(page 89).

To delete a flow classification, see “Deleting a flow classification”

(page 89).

Deleting a policy
You can delete a policy from a policy group from the Edit Class of Service

dialog.

1 Inthe Policies list in the Edit Class of Service dialog, select the policy that
you want to remove.

2 Click Delete...
The policy is removed from the Policies list.

3 To apply the changes see “Applying IP CoS provisioning changes”

(page 90).

Adding a flow classification
You can add aflow classification to the policy from the Add New CoS Policy

and the Modify CoS Palicy dialogs.

1

In the Add New CoS Policy or Modify CoS Policy dialog, click New...
An Add Flow Classification dialog opens.

Enter values in the Flow Classification Identifier, Port, Prefix and Prefix
Length fields, and select a Protocol from the drop down list.

Click OK to close the Add Flow Classification dialog.

Note: If any of the data entered in the fields is invalid, a message dialog
opens indicating which field is invalid and why. Correct the data and click
OK again.
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4

5

Click OK to close the Add New CoS Policy dialog.
The Edit Class of Service dialog remains open.

Proceed to “Applying IP CoS provisioning changes” (page 90).

Modifying a flow classification
You can modify an existing flow classification in a policy by launching the

Modify Flow Classification dialog from the Add New CoS Policy or Modify
CoS Policy dialogs.

1

6

From the Flow Classification list in the Add New CoS Policy or Modify CoS
Policy dialog, select the flow classification that you want to modify.

Select Modify...
A Modify Flow Classification dialog opens.

Edit the Flow Classification Identifier, Port, Prefix, and Prefix Length fields
and select a Protocol from the drop-down list.

Click OK to close the Modify Flow Classification dialog.

Note: If any of the data entered in the fields is invalid, a message dialog
opens indicating which field is invalid and why. Correct the data and click
OK again.

Click Ok to Close the Add New CoS Policy or Modify CoS Policy dialog.
The Edit Class of Service dialog remains open.

Proceed to “Applying IP CoS provisioning changes” (page 90).

Deleting a flow classification
You can delete an existing flow classification from a policy.

1

From the Flow Classification list in the Add New CoS Policy or Modify CoS
Policy dialog, select the flow classification that you want to delete.

Select Delete...

The selected flow classification is removed from the Flow Classification
list.

Click OK to close the Add New CoS Policy or Modify CoS Policy dialog.
The Edit Class of Service dialog remains open.

Click Apply.

An Edit Policy Group progress dialog opens.
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5

Click OK.

Applylng IP CoS provisioning changes

In the Edit Class of Service dialog, click Apply.
The Confirm Provisioning dialog opens.

Note: New VRs subsequently added to the VPN will have this policy
group applied to them.

Note: The Confirm Provisioning dialog does not open when there are no
VRs in the VPN.

If any of the data entered in the details panel is invalid, a message dialog
opens indicating which fields are invalid. Correct any invalid data and click

Apply again.
In the Confirm Provisioning dialog, select the provisioning views that you

would like to start from and save to, the select the Activate view and
Commit view as desired.

Click OK.

A progress dialog opens showing the progress of the Apply CoS
command.

Note: If an error occurs while the operation is in progress, a message
dialog opens that indicates the error. The operation stops and the tool
disconnects from any devices to which it is connected.

VR selected menu procedures

From the VR selected menu, you can exclude aVR from a VPN and delete
the VR component.

Excluding or deleting a VR from an existing VPN

1

In the IP VPN global update tool main window, expand the hierarchy to
display the VR you wish to remove.

Click the mouse menu button on the VR that you want to remove.
From the pop-up menu, select Remove.
The Exclude VR dialog opens.

To exclude the VR from VPN, select Exclude VR from VPN and click OK.
The VR component is not deleted from the device.
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To remove the VR from VPN and delete the VR component from the
device on which it has been provisioned, select Exclude VR from VPN
and Delete VR component and click OK.

5 A Confirm Provisioning Options dialog opens.

6  Confirm or edit the Save From Provisioning View options and Save to
Provisioning View options.

7  Click OK.

A progress dialog opens showing the progress of the exclude VR
command.

If an error occurs while the operation is in progress, a message dialog
opens that indicates the error. The operation stops and the tool
disconnects from any devices to which it is connected.

Apply is disabled. The status message in the details panel changes to
Stored in the server database.

The VR is removed from the VPN. If you selected Exclude VR from VPN
and Delete VR, the VR component is also deleted.

Creating a new customer VPN
Creating a customer VPN involves the following procedures:

e “Adding anew customer” (page 80)
e “Adding anew VPN to a customer” (page 82)
 “AddingaVRtoaVPN” (page 83)
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Chapter 6
Using the IP VPN global update tool CLI

For information on how to use the IP VPN global update tool CLI, seethe
following sections:

* “CreatingaVPN" (page 93)

» “DeletingaVPN” (page 97)

 “AddingaVRtoaVPN” (page 97)

 “ExcludingaVR fromaVPN" (page 98)

e “Adding apolicy grouptoaVR inaVPN" (page 99)

» “Deleting apolicy group fromaVRinaVPN” (page 101)
e “Configuring atosMask attribute on aVR” (page 102)

e “Updating a password” (page 103)

Note 1. The following procedures provide command syntax examples.

Note 2: For detailed information on commands, see “ Commands”
(page 105).

Creating a VPN

When you create a VPN, you must also create the VR component on the
Passport switch and include the VR in the VPN.
1 Create a customer and VPN in the database:

createvpn vpnl 100 custonerl 200 1 system mypassword

where:
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<vpnl> isthe name of the VPN being created.
<100> is the VPN ID.

<cust oner 1> is the customer name.

<200> is the customer ID.

<1> is the autonomous system identifier.

<syst en® isthe userlD for the VPN. The userID is used as a default for
other commands when no userID is specified.

<mypasswor d > is the password for the VPN. This password is used as
a default for other commands when no password is specified.

2 Create the VR components to include in the VPN:

createvr vpnl customerl

-vr vpnl PP1 -vr vpnl PP2 -vr vpnl PP3
-save U vpnl_view

-activate

where:

<vpnl> is the name of the VPN you created.

<custoner 1> is the name of the customer who owns the VPN.
-vr isthe VR you are creating.

<PP#> is the Passport on which you are creating the VR. In this
example, the VR is being created in three nodes, PP1, PP2, and PP3.

-save saves a specific view.

<U> indicates the provisioning mode. In this example, the mode is user
specified.

<vpnl_vi ew> is a complete provisioning file hame, which you need to
specify if the mode is user specified.

-activate activatesthe VR.

3 After you create the VRs on each of the nodes, include the new VRs in
the VPN.

a. Toinclude the VRs separately:

includevr vpnl customerl

-vr vpnl PP1 200.1.1.1 255.255.255.0 100.1.1.1 255.255.255.0 1
-start U vpnl_view

-save U vpnl view
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-activate

includevr vpnl customerl

-vr vpnl PP2 200.1.1.2 255.255.255.0 100.1.2.1 255.255.255.0 0
-start U vpnl_view

-save U vpnl_view

-activate

includevr vpnl customerl

-vr vpnl PP1 200.1.1.1 255.255.255.0 100.1.1.1 255.255.255.0 1
-start U vpnl_view

-save U vpnl_view

-activate

where:

<vpnl> isthe VPN name.

<custoner 1> is the name of the customer who owns the VPN.
-vr specifies the VR to include in the VPN.

<PP#> is the name of the Passport on which the VR exists.

<200. 1. 1. 1> s the private IP address of the VR included in PP1.

<255. 255. 255. 0> is the network mask of the private IP address
for PP1.

<100. 1. 1. 1> s the public IP address of the VR included in PP1.

<255. 255. 255. 0> is the network mask of the public IP address
for PP1.

<1> indicates that the VR should be a route reflector. If this VR is
set to be a route reflector, all other non-route reflector VRs in the VPN
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are set to clients. The number 1 sets the VR to a route reflector, and
0 does not set the VR as a route reflector.

-start begins provisioning for a specific view. If you do not specify
this parameter, the tool uses the current view.

[ U indicates the mode in which to start a provisioning session is
user specified.

<vpnl_vi ew> isacomplete provisioning file name that you specify
when the mode is user specified.

-save saves a specific view.

-activate activates the edit views on all the Passports in the
VPN.

To include VRs, using a VR file:

includevr vpnl customerl
-vrfile vrfile.txt

-start U vpnl_view

-save U vpnl view
-activate

where:

<vpnl> isthe VPN name

<cust oner 1> is the name of the customer who owns the VPN.
-vrfile specifiesthe VR file that contains the list of VRs.
<vrfile.txt> isthe name of the VR file.

-start begins provisioning for a specific view. If you do not specify
this parameter, the tool uses the current view.

[ U indicates the mode in which to start a provisioning session is
user specified.

<vpnl_vi ew> isacomplete provisioning file name that you specify
when the mode is user specified.

-save saves a specific view.

-activate activates the edit views on all the Passports in the
VPN.

VR File Format

The example VR file consists of the following format and information:
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Deleting a VPN
1

vpnl PP1 200.1.1.1 255.255.255.0 100.1.1.1
255.255.255.0 1

vpnl PP2 200.1.1.2 255.255.255.0 100.1.2.1
255.255.255.0 0

vpnl PP3 200.1.1.3 255.255.255.0 100.1.3.1
255.255.255.0 0

Delete the VPN:

deletevpn vpnl customerl
[-start U vpnl_view]

-save U vpnl_view
-activate

where:
<vpnl> isthe name of the VPN that you want to delete.
<cust oner 1> is the name of the customer who owns the VPN.

[-start] begins provisioning for a specific view. If you do not specify
this parameter, the tool uses the current view.

<U> indicates the mode in which to start a provisioning session is user
specified.

[ <vi ewname>] is a complete provisioning file name, which you specify
when the mode is user specified.

-save saves a specific view.

-activate activates the edit views on all the Passports in the VPN.

Adding a VR to a VPN

In this example, the VR vpnl already exists on the node PP4. If the VR did
not exist, you would need to use the createvr command to createit.

1

Add a VR to an existing VPN:

includevr vpnl customerl

-vr vpnl PP4 200.1.1.4 255.255.255.0 100.1.4.1 255.255.255.0 0
-start U vpnl_view

-save U vpnl_view

-activate

where:
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<vpnl> isthe VPN name.

<cust oner 1> is the name of the customer who owns the VPN.
-vr specifies a VR to add to the existing VPN.

<PP4> is the name of the Passport on which the VR exists.
<200. 1. 1. 4> s the private IP address of the VR.

<255. 255. 255. 0> is the network mask of the private IP address for
the VR.

<100. 1. 4. 1> s the public IP address of the VR.

<255. 255. 255. 0> is the network mask of the public IP address of the
VR you are adding.

<0> indicates the VR is not a route reflector.

-start begins provisioning for a specific view. If you do not specify this
parameter, the tool uses the current view.

[ U indicates the mode in which to start a provisioning session is user
specified.

<vpnl_vi ew> is a complete provisioning file name that you specify
when the mode is user specified.

-save saves a specific view.

-activate activates the edit views on all the Passports in the VPN.

Excluding a VR from a VPN

This procedure excludes aVR from aVPN. This procedure does not delete
the VR component. It only updatesthe ARPtable, tunnel, and border gateway
protocol (BGP) information for the VR. If you want to deletethe VR
component, use the deletevr command.

1

Exclude a VR from an existing VPN:

excludevr vpnl customerl
-vr vpnl PP2

-save U test_view
-activate

where:
<vpnl> isthe VPN name.

<cust oner 1> is the name of the customer who owns the VPN.
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-vr specifies the VR to exclude from the VPN.
<PP2> is the name of the Passport on which to exclude the VR.
-save saves a specific view.

[ U indicates the mode in which to start a provisioning session is user
specified.

<t est _vi ew> is a complete provisioning file name that you specify
when the mode is user specified.

-activate activates the edit views on all the Passports in the VPN.

Deleting a VR
This procedures deletes a VR from a VPN:

1 Delete the VR

deletevr vpnl customerl
-vr vpnl PP2

-save U vpnl_view
-activate

where:

<vpnl> isthe VPN name.

<custoner 1> is the name of the customer who owns the VPN.
-vr specifies the VR to delete from the VPN.

<PP2> is the name of the Passport on which to delete the VR.
-save saves a specific view.

[U indicates the provisioning mode. In this example, the mode is user
specified.

<vpnl_vi ew> isacomplete provisioning file name, which you need to
specify if the mode is user specified.

-activate activates the edit views on all the Passports in the VPN.

Adding a policy group to a VR in a VPN

1 Add a policy group to a VR in a VPN:
a. Add a class of service (CoS) policy to all the VRs in a VPN.

addpolicy vpnl customerl policyl pgl 2
-flowClassification 1 10.1.0.0 16 tcp 8080
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-save U vpnl_view
-activate

where:

<vpnl> isthe VPN that contains the VR to which you are adding
the policy.

<cust oner 1> isthe name of the customer who owns the VPN.
<pol i cyl> isthe name of the policy within the policy group.
<pgl> is the name of the policy group.

<2> is the CoS index.

-flowd assi fication specifies a flow classification.

<1> specifies the flow class.

<16> is the length of the prefix.

<t cp> specifies the TCP protocol.

<8080> is the port number.

-save saves a specific view.

<U> indicates the mode in which to start a provisioning session is
user specified.

<vpnl_vi ew] isacomplete provisioning file name that you specify
when the mode is user specified.

-activate activates the edit views on all the Passports in the
VPN.

Add a policy to only one VR in the VPN:

addpolicy vpnl customerl policyl pgl 2
-vr vpnl PP2

-flowClassification 1 10.1.0.0 16 tcp 8080
-save U vpnl_view

-activate

where:

<vpnl> isthe VPN that contains the VR to which you are adding
the policy group.

<cust oner 1> is the name of the customer who owns the VPN.

<pol i cyl> isthe name of the policy within the policy group.
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<pgl> isthe name of the policy group.

<2> isthe CoS index consisting.

-vr specifies the VR on which to add a policy.
<PP2> is the Passport node that contains the VR.
-flowd assi fication specifies a flow classification.
<1> specifies the flow class.

<10. 1. 0. 0> is the prefix.

<16> s the length of the prefix.

<t cp> indicates the TCP protocol.

<8080> is the port number.

-save saves a specific view.

<U> indicates the mode in which to start a provisioning session is
user specified.

<vpnl_vi ew] isacomplete provisioning file name that you specify
when the mode is user specified.

-activate activates the edit views on all the Passports in the
VPN.

Deleting a policy group from a VR in a VPN
The example that follows only deletes the flowClassification option from a
policy. It does not delete the entire policy.

1

Delete the flowClassification option from a policy:

deletepolicy vpnl customerl policyl pgl 2
-flowClassification 1

-start (U) vpnl_view

-save U vpnl view

-activate

where:

<vpnl> isthe VPN that contains the VR from which you are deleting the
policy group.
<custoner 1> is the name of the customer who owns the VPN.

<pol i cyl> is the name of the policy within the policy group.
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<pgl> isthe name of the policy group.

<2> isthe CoS index.

-flowd assi fication specifies a flow classification.
<1> specifies the flow class.

-start begins provisioning for a specific view. If you do not specify this
parameter, the tool uses the current view.

<U> indicates the mode in which to start a provisioning session is user
specified.

<vpnl_vi ew] isacomplete provisioning file name that you specify
when the mode is user specified.

-save saves a specific view.

-activate activates the edit views on all the Passports in the VPN.

Configuring a tosMask attribute on a VR

1

Configure a type of service (TOS) mask attribute on a VR in a VPN:

settosmask vpnl customerl policyltosMask
-start U vpnl_view

-save U vpnl view

[-activate]

where:

<vpnl> isthe VPN that contains the VR for which you are configuring
the tosMask attribute.

<custoner 1> is the name of the customer who owns the VPN.
<pol i cyl> isthe name of the policy within the policy group.

[ <t os_mask>] isthe ToS mask value.

-vr specifies the VR.

<vr 1> isthe VR in the policy group.

-start begins provisioning for a specific view. If you do not specify this
parameter, the tool uses the current view.

<U> indicates the mode in which to start a provisioning session is user
specified.

<vpnl_vi ew> is a complete provisioning file name, which you specify
when the mode is user specified.

241-6001-601 14.3RSUP



Chapter 6 Using the IP VPN global update tool CLI 103

-save saves a specific view.
-activate activates the edit views on all the Passports in the VPN.
Updating a password

This procedure updates the default passwords for all Passport nodes in the
VPN.

1 Update the default password.

updatepasswd vpnl customerl system mypasswd
-default

where:

<vpnl> isthe VPN name.

<custoner 1> isthe name of the customer who owns the VPN.
<syst en® is the userlD to log in to the Passports.
<mypasswd> is the password for the userID.

-defaul t indicates that you are updating all the default userlDs and
passwords for all Passport nodes in the VPN.
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Chapter 7
Commands

help

For a description of the commands for the IP VPN global update tool, seethe
following sections:

e “help” (page 105)

e “createvpn” (page 106)

* “createvr” (page 107)

e “includevr” (page 108)

e ‘“excludevr” (page 111)

e “deletevr” (page 113)

e “deletevpn” (page 115)

e ‘“settosmask” (page 116)

e ‘“settosmarking” (page 118)
e “addpolicy” (page 120)

» “deletepolicy” (page 122)

o “listvpn” (page 124)

o “listcustomer” (page 125)

* “updatepasswd” (page 125)

Use the help option to obtain help on the commands and optionslisted in this
section.
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The command syntax for the help command is as follows:
<command> - hel p

where:
<command> isthe command you want to obtain help for.
An example of the help command follows:

createvpn -help

createvpn
Use the createvpn command to initialize the database tables for the VPN that

you are creating. The createvpn command does not perform any provisioning
commands on the Passport nodes.

The command syntax for the createvpn command is as follows:

createvpn <vpn> <vpn_id> <custoner> <customner_id> /

<as_id>
[ <useri d> <passwd>]
[ - aut 0]
[-1og <logfile>]
[ - hel p]
where:

<vpn> isthe name of the VPN you want to create.

<vpn_i d> istheuniqueidentifier for the VPN.

<cust oner > isthe name of the customer who will own the VPN.

<cust oner _i d> isthe unique ID of the customer.

<as_i d> istheautonomous system identifier.

[<useri d><passwd>] where<useri d> isadefault userid that you can use

tologinto al Passport nodesin the VPN and <passwd> isadefault
password for the userid.
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[-auto] isthe option to specify auto discovery mode.

[-1 og <l ogfil e>] isthe option to specify alog file. If you specify thelog
file, logging is turned on. If you do not specify the log file, adefault log file
isused. <l ogfi | e> isthename of thelogfile

[ - hel p] displays help for the command.

An example of the createvpn command follows:

createvpn vpnABC 101 cust ABC 201 1

createvr
Use the createvr command to create a VR component.

The command syntax for the createvr command is as follows:

createvr <vpn> <custoner>

-vr <vr> <pp> [<userid> <passwd>]]
[-start<nmpode> [<key> | <date> | <vi ewnanme>]]
-save<node> [<key> | <date> | <vi ewnane>]
[-activate]

[-commit]

[-1og <logfile>]

[-hel p]

where:

<vpn> isthe VPN name.

<cust ormer > isthe name of the customer who will own the VPN.
-vr isthe VR you are creating. You can specify more than one VR.
<vr > isthe name of the VR being created.

<pp> isthe Passport on which you are creating the VR.

[ <userid>] istheuserlD tologin to the Passport switch.

[ <passwd>] isthe password for the userID.
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includevr

[-start] indicates provisioning will start for a specific view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not supported in this release.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[<dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode isUSER_SPECIFIED.

-save savesaspecificview.
[-activate] activatestheVR.
[-comit] commitstheVR.

[-1 0og <-1ogfil e>] specifiesthename of thelogfile. If you specify thelog
file, logging is turned on.

[-hel p] displayshelp for the command.

An example of the createvr command follows:

createvr vpnABC cust ABC

-vr A PP1

-save USER _SPECI FI ED vpnvi ew_abc
-activate

-comm t

Use the includevr command to include a VR in the VPN. You can include
each VR separately or use a VR file that contains the VRs. (The includevr
command assumes that the VR component currently exists.) The includevr
command updates al tunnelsin the VPN to take into account all the newly
included VRs, aswell as updating all ARP tables of all VRsinthe VPN.
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The includevr command also updates the VR related information in the IP
VPN database.

The command syntax for the includevr command is as follows:

i ncl udevr <vpn> <cust oner >

-vr <vr> <pp> <private_i p> <private_net mask>
<public_i p> <public_net mask> <i sroutereflector>
[ <t opol ogy>] [<userid> <passwd>]

[-vr <vr> <pp> <private_i p> <privat e_net mask>
<public_i p> <public_net mask> <i sroutereflector>
[ <t opol ogy>] [<userid> <passwd>]]

[-vr_file <vrfile>]

[-db]

[-start<npde> [<key> | <date> | <viewnane>]]
-save <npde> [<key> | <date> | <vi ewnane>]
[-activate]

[-commit]

[-1og <logfile>]

[-help]

where:
<vpn> isthe VPN name.
<cust oner > isthe name of the customer who owns the VPN.

-vr gpecifiesaVR to beincluded in the VPN. You can specify more than
one VR in the includevr command.

<vr > the name of the VR you are including.

<pp> isthe name of the Passport on which the VR exists.
<private_i p> istheprivate |P address of the VR.

<privat e_net mask> isthe network mask of the private |P address.
<publ i c_i p> isthepublic IP address of the VR.

<publ i c_net mask> isthe network mask of the public IP address.
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<i srouterefl ector> indicateswhether or not the VR should be aroute
reflector. If the VR is set to be aroute reflector, al other non-route reflector
VRsintheVPN aresettoclients. If thelS ROUTE_REFLECTOR parameter
is1, the VR is set to be aroute reflector, and the BGP peerage is updated. If
thelS ROUTE_REFLECTOR parameter is 0, the VR is not set to be aroute
reflector.

[<t opol ogy>] istheoption to specify either ahub or spoke. If the VPN
was created in auto discovery mode, the default valueis hub.

The VR is assumed to be spoke if:
» theauto option was specified in the createvpn command, and

« thehub and isroutereflector options are not specified in the includevr
command

[<userid>] istheuserlD tologin to the Passport switch.
[ <passwd>] isthe password for the userID.

[-vr_file] alowsyoutoreadintheVRstobeincludedinthe VPN
through an ASCI| text file. Thisfile containsalist of theVVRswiththeir public
and private |P addresses and network masks.

[<vrfile>] isthename of the VR filewhich containsalist of VRsto be
included in the VPN.

[-db] updates the database, but does not perform any provisioning on the
switches. This option isuseful if you have already provisioned the VRs, and
only want to update the database.

[-start] beginsprovisioning for aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not supported in this release.)
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excludevr

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified asYYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode is USER_SPECIFIED.

-save savesaspecific view.
[-activate] activatesthe edit viewson all the Passportsin the VPN.
[-commit] commitsthe views on al the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify the log
file, logging is turned on.

[- hel p] displays help for the command.

An example of the includevr command follows:

i ncl udevr vpnABC cust ABC

-vr D PP3 200.1.1.4 255.255.255.0 40.1.1.1 255.0.0.0 0
-start USER _SPECI FI ED vpnvi ew_abc

-save USER SPECI FI ED vpnvi ew_abc

-activate

Use the excludevr command to remove a VR from aVPN. The command
deletes any related entries from the IP VPN database. It also updates the
tunnels of all the VRsinthe VPN, aswell asthe ARP tables of the VRs. The
command syntax for the excludevr command is as follows:

excl udevr <vpn> <cust oner >

-Vr <vr> <pp>

[-vr <vr> <pp>]

[-vr_file <vrfile>]

[-db]

[-start <npde> [<key> | <date> | <vi ewnane>]]
-save <npde> [ <key> | <date> | <vi ewnane>]
[-activate]
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[-commit]
[-1og <logfile>]
[ - hel p]

where:
<vpn> isthe VPN name.
<cust oner > isthe name of the customer who owns the VPN.

-vr specifiesaVRto beexcluded from the VPN. You can specify morethan
one VR in the excludevr command.

<vr > isthe name of the VR that you are excluding.
<pp> isthe name of the Passport on which the VR exists.

[-vr_file] letsyoureadintheVRstobeexcludedfromthe VPN through
an ASCII text file. Thisfile contains alist of the VRs with their public and
private | P addresses and network masks.

[<vrfile>] isthename of the VR filewhich containsalist of VRsto be
excluded from the VPN.

[-db] updates the database, but does not perform any provisioning on the
switches. This option isuseful if you have already provisioned the VRs, and
only want to update the database.

[-start] beginsprovisioningfor aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not supported in thisrelease.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.
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deletevr

[ <dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode is USER_SPECIFIED.

-save savesaspecific view.
[-activate] activatesthe edit viewson all the Passportsin the VVPN.
[-commit] commitsthe viewson all the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify the log
file, logging is turned on.

[-hel p] displays help for the command.

An example of the excludevr command follows:

excl udevr vpnABC cust ABC
-vr B PP2

-vr C PP3

-activate

- save

The deletevr command lets you specify the VRsto be deleted froma VPN in
a Passport node.

The command syntax for the deletevr command is as follows:

del etevr <vpn> <custoner> -vr <vr> <pp> [<userid>
<passwd>]

[-vr <vr> <pp> [<userid> <passwd>]...

[-start <node> [ <vi ewnanme>]]

-save <node> <vi ewnane>

[-activate]

[-commit]

[-1og <logfile>]

[-help]

where:
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<vpn> isthe name of the VPN for which the vr(s) are being del eted.
<cust oner > isthe name of the customer who owns the VPN.

-vr Thisoption is used to specify avr to be deleted.

<vr> The name of the vr to be deleted.

<pp> The name of the passport node from which the vr will be deleted.
<userid> Theuser ID used to login to the passport node.

<passwd> The password for the above user ID.

[-start] Thestart option is used to specify the view to be used when
entering provisioning on the passport nodes in the VPN.

[ <node>] appliesto the view option for the start option. Select one of:
CURRENT (CUR), EDIT (E), COMMITED (COM), USER_SPECIFIED
(U), DATED (D), KEYED (K). For USER_SPECIFIED, DATED, or
KEYED, the user al so hasto specify aviewname or adate or akey depending
on the option.

Note: DATED and KEYED are not implemented in this release.

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified asYYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode isUSER_SPECIFIED.

-save Thesave option isused to specify a specific view to save any
provisioning changes on the passport nodesin the VPN. The view <mode>
can be one of the following: USER_SPECIFIED (U), DATED (D), or
KEYED (K).
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deletevpn

[-activate] The activate option indicates that the provisioning view on
any affected Passport nodes in the VPN should be activated after the
command has successfully completed.

[-commit] The commit option indicates that the provisioning view on any
affected Passport nodes in the VPN should be committed after the command
has successfully completed.

[-1 og <l ogfil e>] specifiesthe name of thelog file. If you specify thelog
file, logging isturned on. Thelogfileis specified by the <logfile> parameter.
<logfile> should contain the full directory path.

[-hel p] displays help for the command.

The deletevpn command first performs an excludevr command on all the VRs
inthe VPN and then excludes the VPN from the database.

The command syntax for the deletevpn command is as follows:

del et evpn <vpn> <cust oner >

[-start <node> [<key> | <date | <vi ewnane>]]
-save <npde> [ <key> | <date>| <vi ewnane>]
[-activate]

[-commit]

[-1og <logfile>]

[-hel p]

where:
<vpn> isthe VPN name.
<cust oner > isthe name of the customer who owns the VPN.

[-start] beginsprovisioning for aspecific view. If you do not specify this
parameter, the tool uses the current view.
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settosmask

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not, however, supported in this release.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode isUSER_SPECIFIED.

-save savesaspecificview.
[-activate] activatesthe edit viewson all the Passportsin the VPN.
[-commit] commitsthe views on all the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of thelog file. If you specify thelog
file, logging is turned on.

[-hel p] displayshelp for the command.

An example of the deletevpn command follows:

del et evpn vpnABC cust ABC

-save USER _SPECI FI ED vpnvi ew_abc
-activate

-comm t

Use the settomask command to set up atype of service (ToS) mask for aclass
of service (CoS) treatment component.

The command syntax for the settosmask command is as follows:

settosmask <vpn> <custoner> <policygroup> <t osMask>
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[-vr <vr> <pp>

[-start<nmpde> [<key> | <date> | <vi ewname>]]
-save <node> [<key> | <date> | <vi ewnane>]
[-activate]

[-commit]

[-1og <logfile>]

[-hel p]

where:
<vpn> isthe VPN name. The policy is added to all the VRsin this VPN.
<cust oner > isthe name of the customer who owns the VPN.

<pol i cygroup> isthe name of the policy group (consisting of a 20-
character string) that defines a common set of palicies.

<t osMask> isaToS mask value.

[-vr] specifiesalist of VRs on which to perform this command.
[ <vr>] isthename of the VR.

[ <pp>] isthe name of the Passport on which the VR exists.

[-start] beginsprovisioningfor aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEYED and DATED are
not supported in thisrelease.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode is USER_SPECIFIED.
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-save savesaspecificview.
[-activate] activatesthe edit viewson all the Passportsin the VVPN.
[-commit] commitsthe viewson al the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify thelog
file, logging is turned on.

- hel p displays help for the command.

An example of the settosmask command follows:

settosmask vpnABC cust ABC pgl2 2
-save USERSPECI FI ED vpnvi ew_abc
-activate

-commit

settosmarking

Use the settosmarking command to set up a ToS setting for a CoS treatment
component.

The command syntax for the settosmarking command is as follows:
settosmar ki ng <vpn> <cust oner > <pol i cygroup>

[-vr <vr> <pp>]

-set ToS <cos_treat nent> <t os>

[-set ToS <cos_treat ment> <t 0s>]

[-of f <cos_treatment>]

[-on <cos_treat ment >]

[-start <node> [<key> | <date> | <viewnane]]
-save <node> [ <key> | <date> | <viewnane>]
[-activate]

[-commt]

[-1og<l ogfile>]

[-hel p]

where:
<vpn> isthe VPN name. The policy is added to all the VRsin this VPN.

<cust oner > isthe name of the customer who owns the VPN.
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<pol i cygroup> isthe name of the policy group (consisting of a 20-
character string) that defines a common set of policies.

[-vr] specifiesalist of VRs onwhich to perform this command.
<vr> istheVR name.

[ <pp>] isthe name of the Passport on which the VR exists.

-set ToS gpecifiesa ToS setting.

<cos_treat ment > isaninteger (between 1 and 4) that represents the CoS
treatment index.

<t os> isaToSvalue.
[-of f] turnsoff the set ToS marking if thisflag is present.
[-on] turnsonthe set ToS marking if thisflag is present.

[-start] beginsprovisioning for aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not supported in this release.)

[<key>] iscomposed of letters, digits, and underscores. A key cannot begin
with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode isUSER_SPECIFIED.

-save savesaspecificview.

[-activate] activatesthe edit viewson all the Passportsin the VPN.
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[-commit] commitsthe views on al the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify thelog
file, logging is turned on.

- hel p displays help for the command.

An exampl e of the settosmarking command follows:

settosmar ki ng vpnABC cust ABC pgl2
-setToS 1 3

-off 1

-save USER SPECI FI ED vpnvi ew_abc
-activate

-conmi t

addpolicy
Use the addpolicy command to add a flow classification or ToSMap to a
policy. If the policy does not exidt, it is created.

The command syntax for the addpolicy command is as follows:

addpol i cy <vpn> <cust oner > <pol i cynanme> <pol i cygr oup>
[ <cos_i ndex>]

[-vr <vr> <pp]

[-tosMap <tos>...]

[-flowC assification <flowlass_id> <prefix>
<prefi xLengt h> <protocol > <port>]
[-start<npde> [<key> | <date> | <viewnane>]]
-save <npde> [<key> | <date> | <vi ewnane>]
[-activate]

[-commit]

[-1og<l ogfil e>]

[-help]

where:
<vpn> isthe VPN name.
<cust oner > isthe name of the customer who owns the VPN.

<pol i cyname> isthe name of the policy within the policy group.
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<pol i cygroup> isthe name of the policy group (consisting of a 20-
character string) that defines a common set of policies.

[ <cos_i ndex>] isthe CoSindex (consisting of avalue of 0, 1, 2, or 3).

[-vr] specifiesalist of VRson which to perform this command. If you do
not use this option, the policy is added to all VRsin the VPN.

[<vr>] istheVRin the policy group that you are adding.

[ <pp>] isthe name of the Passport.

[-tosMap] specifiesaToS setting.

[ <tos>] specifiesaToSvalue.

[-flowd assification>] specifiesaflow classification.
[-flowclass_id>] specifiestheflow classification identifier.
[ <prefix>] specifiesthe prefix for the flow classification.

[ <prefixLength>] isthelength of the prefix.

[ <pr ot ocol >] isthe protocol (either TCP, UDP, or ICMP).

[ <port>] gspecifiesthe port number.

[-start] beginsprovisioningfor aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEYED and DATED are
not supported in thisrelease.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.
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[ <dat e>] isthevalid date (specified as YYMMDD).

[ <vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode is USER_SPECIFIED.

-save savesaspecific view.
[-activate] activatesthe edit viewson all the Passportsin the VVPN.
[-commit] commitsthe viewson all the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify the log
file, logging is turned on.

[ - hel p] displays help for the command.

An example of the addpolicy command follows:

addpol i cy vpnABC cust ABC pol icyl pgl2
-flowd assification 1 10.1.0.0 16 tcp 8080
-activate

- save

deletepolicy
Use the deletepolicy command to delete a policy for aVR.

The command syntax for the deletepolicy command is as follows:

del et epol i cy <vpn> <custoner> <pol i cynane>
<pol i cygr oup>

[-vr <vr> <pp]

[ -t osMap]

[-flowCl assification <flowcl ass>]
[-start<nmpode> [<key> | <date> | <vi ewnanme>] ]
-save<node> [<key> | <date> | <vi ewnane>]
[-activate]

[-commit]

[-1og<l ogfil e>]

[-hel p]

where:
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<vpn> isthe VPN name. The policy is added to all the VRsin this VPN.
<cust oner > isthe name of the customer who owns the VPN.
<pol i cyname> isthe name of the policy within the policy group.

<pol i cygr oup> isthe name of the policy group (consisting of a 20-
character string) that defines a common set of policies.

[-vr] specifiesalist of VRsfrom which to delete a policy.
[<vr>] isthe name of the VR from which the policy is being deleted.
[ <pp>] isthe name of the Passport.

[-tosMap] deletesthe ToS map. If you do not specify thisoption, the entire
policy is deleted from the specified VRs.

[-flowd assification] deletesthe specified flow classification from
the policy. If you do not specify this option, the entire policy is deleted.

[ <fl owcl ass>] istheflow classification you wish to delete.

[-start] beginsprovisioningfor aspecific view. If you do not specify this
parameter, the tool uses the current view.

[ <nmode>] appliesto the start and save options. For the start option, select
one of: USER_SPECIFIED (U), KEYED (K), DATED (D), CURRENT
(CUR), or COMMITED (COM). For the save option, select one of
USER_SPECIFIED (U), KEYED (K), or DATED. (KEY ED and DATED are
not supported in thisrelease.)

[ <key>] iscomposed of letters, digits, and underscores. A key cannot
begin with an underscore or exceed more than six characters.

[ <dat e>] isthevalid date (specified asYYMMDD).

[<vi ewname>] isacomplete provisioning file name. Use this parameter
when the mode is USER_SPECIFIED.
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-save savesaspecificview.
[-activate] activatesthe edit viewson all the Passportsin the VPN.
[-commit] commitsthe views on al the Passportsin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify thelog
file, logging is turned on.

[-hel p] displayshelp for the command.

An example of the deletepolicy command follows:

del et epol i cy vpnABC cust ABC policyl pgl2
-flowd assification 1 tcp 8080

-activate

-save

listvpn
Use the listvpn command to list the VPNs in the Passport network.

The command syntax for the listvpn command is as follows:

i stvpn <vpn> <cust oner >
[-vr]

[-pp]

[-vpn_id]

[-1og<l ogfil e>]

[ - hel p]

where:

<vpn> isthe VPN name.

<cust omer > isthe name of the customer who owns the VPN.
[-vr] displaysthe VRsincludedin the VPN.

[-pp] displaysthe Passport nodesin the VPN.

[-vpn_id] displaysthelD of the VPN.
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[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify the log
file, logging is turned on.

[-hel p] displayshelp for the command.

An example of the listvpn command follows:

i stvpn vpnABC cust ABC
-vr

listcustomer
Use the listcustomer command to list the VPNs for a specific customer.

The command syntax for the listcustomer command is as follows:

| i stcustonmer <custoner> <-vpn | -custoner_id>
[-1og<l ogfil e>]
[ - hel p]

where:

<cust oner > isthe name of the customer who owns the VPN.

<-vpn |- cust ormer _i d> where - vpn displays the VPNs owned by the
customer and - cust oner _i d displaysthe ID of the customer.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify thelog
file, logging is turned on.

[-hel p] displayshelp for the command.

An example of the listcustomer command follows:

|i stcustoner cust ABC
-vpn
updatepasswd

Use the updatepasswd command to update your userlD or password for
logging into a Passport node.
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The command syntax for the updatepasswd command is as follows:

updat epasswd <vpn> <cust oner> <useri d> <passwd>
[-pp <pp>]

[-defaul t]

[-1og<l ogfil e>]

[ - hel p]

where:

<vpn> isthe VPN name.

<cust omer > isthe name of the customer who owns the VPN.
<useri d> istheuserID tolog in to the Passport.

<passwd> isthe password for the userID.

[- pp] updates only the userlD and password for the named Passport node.
If this option is not used, all the nodesin the VPN are updated.

[ <pp>] isthe Passport for which the userID is being set.

-def aul t updatesonly thedefault userl D and password for all the Passport
nodesin the VPN.

[-1 og <l ogfil e>] specifiesthe name of the log file. If you specify the log
file, logging is turned on.

[-hel p] displays help for the command.

An example of the updatepasswd command follows:

updat epasswd vpnABC cust ABC
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